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Disclaimer
The authors declare that there are no warranties,
expressed or implied, which apply to the software
contained herein. By acceptance and use of said
software, which is conveyed to the user without

consideration by the authors, the user hereof expressly
waives any and all claims for damage and/or suits for
or by reason of personal injury, or property damage,

including special, consequential or other similar
damages arising out of or in any way connected with

the use of the software contained herein.
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The purpose of this guide is to provide a quick
reference guide to the SDPS for windows (version 5.x)
suite of programs and to develop working experience
through the application of examples. This guide is not
designed to be a tutorial in ground control engineering
or in subsidence engineering. It is assumed that the

user is already familiar with the basic principles of
ground deformation prediction and pillar stability

evaluation.

As of version 5.1, the SDPS suite of programs includes
the Pillar Stability Analysis programs (ALPS and

ARMPS) developed by NIOSH.
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List of Symbols

w the panel width; the minimum dimension of a panel

h panel depth; the vertical distance between the mining horizon and
the surface; also known as the overburden thickness

m the seam thickness; the extraction thickness (note that the
extraction thickness may be different than the seam thickness)

R the extraction ratio

R* the adjusted extraction ratio

d the distance of the inflection point from the rib (a positive value
indicates that the position of the inflectionpoint is inby); also
referred to as the “edge effect”

$ the influence angle

r the influence radius

Smax the maximum subsidence

a the maximum subsidence factor

Bs the strain coefficient

%HR the percent hardrock in the overburden

Wp the pillar width

Hp the pillar height

Wo the opening width
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Chapter 1: Introduction
The original Surface Deformation Prediction System (SDPS) programs were developed
by the Department of Mining and Minerals Engineering, Virginia Polytechnic Institute
and State University (Virginia Tech), Blacksburg, VA, USA, in 1987, under the
leadership of Dr. Michael Karmis. At the time, the SDPS suite of programs was
developed as a research tool, rather than an integrated approach to the prediction of
surface deformations. They were based on field studies and the prediction methods
were adapted to eastern U.S. mining and geological conditions.

The SDPS software has since been modified and updated, in order to facilitate user
interaction and has been transformed from a research methodology to an engineering
tool for the field engineer and the mine planning team. The previous version (version
4.x), was designed to provide an integrated approach to the problem of calculating and
predicting ground deformations above undermined areas. Based on empirical or site-
specific regional parameters, the operator was able to calculate a variety of ground
deformation indices, according to one or more numerical formulations.

Additionally, it should be noted that version 4.x of the SDPS package was also
enhanced by an independent module used to calculate pillar stability, based on four
well accepted pillar strength formulations. This tool was provided in an effort to help
the operator evaluate the stability of pillars in room-and-pillar mines.

SDPS version 4.x was written for the DOS environment and provided pull down menus,
mouse support and context sensitive help. It was limited by the DOS limitations, such
as the need for special peripheral (printer, plotter, etc.) drivers, as well as by the
infamous 640KB limit on program size and data arrays.

Funding for the SDPS related work, leading to version 4.x, was provided by various
federal and state agencies, the mining industry and Virginia Tech.

SDPS version 5.x constitutes the latest update of SDPS software, developed
specifically for the Microsoft Windows® environment (SDPS for Windows). In this
respect, all programs fully utilize the central management of computer resources (i.e.
memory, use of the clipboard, peripherals, etc.) provided by the Microsoft Windows®.
All SDPS version 5.x programs are developed in the Visual Basic 6.0 programming
language (professional edition).

The development of the Windows version of SDPS (version 5.x) was performed by Dr.
Michael Karmis and Dr. Zach Agioutantis under a contract from the Office of Surface
Mining, Reclamation and Enforcement. Software development was supervised by Dr.
Zach Agioutantis. Version 5.0 was released in December, 1998.

The authors would like to acknowledge the technical comments, discussions and
suggestions of Dr. Jesse Craft, Geologist, Dr. Kewal Kohli, Mining Engineer and Ms.



SDPS Quick Reference Guide, February 2002 12

Lois Uranowski, Environmental Engineer, Appalachian Regional Coordinating Center,
Office of Surface Mining, Reclamation and Enforcement.

Additional thanks are due to Ms. Ann Stewart-Murphy, Mr. Steven J. Schafrik, and Mr.
David A. Newman for technical comments and for troobleshooting different routines of
the SDPS programs.

The SDPS (version 4.x) and SDPS for Windows (version 5.x) software are marketed by
Carlson Software under a licensing agreement from Virginia Tech Intellectual
Properties.

Carlson Software may be contacted by:
• phone: (606) 564-5028
• fax: (606) 564-6422
• e-mail: info@carlsonsw.com
• internet: http://www.carlsonsw.com
• post Carlson Software,

102 West 2nd St.,
Suite 200,
Maysville,
KY 41056, USA



SDPS Quick Reference Guide, February 2002 13

Suggested Minimum

Windows 95 / 98 / NT4 / 2000 Windows 95 / NT3.51

Pentium based unit 80486DX based unit

SVGA interface, 1024x768, 256 colors VGA interface, 800x600, 16 colors

15MB disk space 7MB disk space

Laser printer or color inkjet printer Any printer supported by windows

Adobe Acrobat Reader (to read this
tutorial in electronic format)

Table 1.1.1: System requirements for the SDPS suite of programs

1.1 Requirements
The hardware and operating system requirements for installing the SDPS suite of
programs are shown in Table 1.1.1.
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1.2 Installing / UnInstalling SDPS
SDPS for Windows (version 5.x) covers all 32bit platforms such as Windows 95,
Windows 98, as well as the Windows NT series (WinNT 3.51, WinNT 4.0, etc.).

1.2.1 Installing from a CDROM
Insert the CDROM in the appropriate drive and locate the single executable file on the
root directory which contains the letters SDPS (i.e. SDPS51.EXE or SDPS52.EXE,
etc.). Double-click on the appropriate installation file as described previously. Note
that if the autorun feature of the CDROM drive is enabled, installation may start
automatically. Follow the prompts of the installation package. For convenience select
the default settings.

You may optionally install the Adobe Acrobat Reader software, which
included in the distribution media for your convenience. To do this,
double click on the appropriate file (e.g. AR302.EXE, AR405.EXE,
etc.). You may obtain the latest version of the latter product through
the internet (www.adobe.com) free of charge.

1.2.2 Installing from diskettes
Insert the first diskette in the appropriate drive and locate the single executable file on
the root directory which contains the letters SDPS (i.e. SDPS50.EXE or SDPS51.EXE,
etc.). Double-click on the appropriate installation file as described previously. Follow
the prompts of the installation package. For convenience select the default settings.

Note that the Adobe Acrobat Reader is not distributed in the diskette version.

1.2.3 Registration
When the SDPS package is first installed then upon execution of any program module,
the indication “Demo version” will be visible. Also, the main picture in each module will
be overwritten by bright red letters. When the package is registered, these messages
do not appear. To register the product, execute the main SDPS module and click on
the “Register” button. Enter the user name and note the license code generated by the
program. Contact the supplier of the program for a license key. Enter the license key
and click on “Save License”. Once registration is successful, the registration button on
the main menu will be disabled.

1.2.4 Uninstalling
To uninstall the SDPS software, switch to the installation directory, i.e. “c:\Program
Files\SDPS for Windows”, and then switch to the “SETUP” directory within the
installation directory. Run the SETUP.EXE program in that directory and follow the
prompts.

Optionally you may also uninstall the program by executing the “Add/Remove
Programs” icon in the “Control Panel” directory of your Windows platform.
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SDPS.EXE Main Menu Program
PROF.EXE Profile Function Program
INFL.EXE Influence Function Main Program
INFLSOLV.EXE Influence Function Calculation Module (should not be

executed in stand-alone mode)
GRAF.EXE Graphing Program
PILL.EXE Pillar Stability Program
ALPS.EXE Analysis of Longwall Pillar Stability Program

ARMPS.EXE Analysis of Retreat Mining Pillar Stability

SDPS.HLP SDPS Help File (may be accessed as stand-alone and
through the programs)

QREF.PDF Quick Reference Guide (requires Acrobat reader from
Adobe)

Table 1.3.1: Files distributed with SDPS

1.3 SDPS Software Overview
Table 1.3.1 explains the function of each of the programs included in the SDPS
package.

Note:
The individual application programs may be executed as stand-alone or through the
SDPS main menu program.
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1.4 SDPS Features

Menu System
• Pull-down menus
• Easy to use input forms
• Check boxes, option buttons, command buttons, combo boxes
• Integrated graphics
• Metric and imperial (English) units
• Context sensitive help (one help file for all programs)
• General program options (settings)
• Custom program options
• Standard file selection dialog
• Standard print dialog

File System
• ASCII files
• Custom path support for data files
• Redefinable file extensions
• Multiple line description for each project

Peripherals
• Integrates seamlessly with devices supported by the Windows environment
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Figure 1.5.1: General configuration options

1.5 General Configuration of the SDPS
Programs

The general configuration options for the profile function module are shown in Figure
1.5.1. To invoke this form select the menu item Utilities-Settings. The default settings
for all modules are managed using similar forms.

In this form the user can select the default units, the default 3-letter extension for data
files, the default path for data files, and other options such as displaying a command
history window, keeping a recent file list, enabling the toolbar, specifying an external
viewer for viewing large ASCII report files, etc.
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Figure 1.6.1: Example of custom configuration options

1.6 Custom Configuration of the SDPS
Programs

Each module has its own custom configuration options. As an example, the custom
options for the influence function module are shown in Figure 1.6.1. To invoke this form
select the menu item Utilities-Options.
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1.7 Overview of Subsidence Parameters
Maximum Subsidence Factor
The values of maximum subsidence factor, as function of the width-to-depth ratio and
the percent hardrock in the overburden, are shown in the supercritical subsidence
factor tables for longwall panels and for room-and-pillar panels respectively. When
using the profile function method, the subsidence factor is calculated for the actual
width-to-depth ratio of the panel. For example, for a panel with W/h = 0.8 (subcritical)
and %HR = 50% the subsidence factor is equal to 0.38.

When using the influence function method, the technique requires knowledge of the
supercritical subsidence factor, which will subsequently be adjusted through the
superposition concept by the program itself. For example, for a panel with W/h = 0.8
(subcritical) and %HR = 50% the subsidence factor is found for W/h = 1.5
(supercritical) and equal to 0.40.

Notes:
A panel is considered supercritical for W/h greater than 1.2. Due to numerical
approximations there may be slight variations to the supercritical subsidence factors
presented in the supercritical subsidence factor tables.

Inflection Point
The location of the inflection point from the rib, with respect to overburden depth (d/h),
can be estimated based on two empirical curves (see the Inflection Point Diagram).
Both curves were statistically generated from the available field data. The first is an
average curve based on a least squares estimator, while the second is considered an
envelope or conservative curve in the sense that it tends to overpredict the surface
impact of a given excavation area. In essence, this means that for average data the
predicted subsidence profile could be either inside or outside of the measured
subsidence line, whereas for conservative (envelope) data, an attempt is made to keep
the prediction lines outside the measured ones, i.e. overestimate the influence of the
mined area to the surface.

From experience and constant validation of the programs, the authors recommend that,
for Appalachian predictions, improved accuracy is obtained by using the following rule:
determine the d/h ratio using the conservative curve for subcritical panels (W/h < 1.2)
determine the d/h ratio using the average curve for supercritical panels (W/h >= 1.2).

Notes:
Always use the actual width-to-depth ratio.

Angle of Influence
The angle of principal influence ($, beta) is one of the basic parameters used in the
influence function method since it has a major impact on the distribution of the
deformations on the surface. It is measured in degrees from the horizontal and the
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Percent Hardrock in the Overburden

W/h 10% 20% 30% 40% 50% 60% 70% 80%

0.6 0.64 0.59 0.51 0.42 0.34 0.26 0.21 0.16

0.7 0.69 0.63 0.55 0.46 0.36 0.28 0.22 0.18

0.8 0.71 0.65 0.57 0.47 0.38 0.29 0.23 0.18

0.9 0.72 0.66 0.58 0.48 0.38 0.30 0.23 0.19

1.0 0.73 0.67 0.58 0.49 0.39 0.30 0.24 0.19

1.1 0.74 0.68 0.59 0.49 0.39 0.31 0.24 0.19

1.2 0.74 0.68 0.59 0.49 0.39 0.31 0.24 0.19

1.3 0.74 0.68 0.60 0.49 0.40 0.31 0.24 0.19

1.4 0.75 0.69 0.60 0.50 0.40 0.31 0.24 0.19

1.5 0.75 0.69 0.60 0.50 0.40 0.31 0.24 0.19

1.6 0.75 0.69 0.60 0.50 0.40 0.31 0.24 0.19

1.7 0.75 0.69 0.60 0.50 0.40 0.31 0.24 0.19

1.8 0.75 0.69 0.60 0.50 0.40 0.31 0.24 0.19

1.9 0.76 0.69 0.60 0.50 0.40 0.31 0.24 0.19

2.0 0.76 0.69 0.60 0.50 0.40 0.31 0.24 0.19

Table 1.7.1: Calculation of maximum subsidence factors (Smax/m) for longwall panels

average value determined for the Appalachian coalfields is beta=67 deg. The
parameter required for these calculations is the tangent of this angle (i.e. tan$ = 2.31).
The angle of influence is related to the radius of influence as shown in the equation:

where
h = the overburden depth
r = the radius of influence

This value should be determined for each site by fitting a calculated subsidence profile
to a measured subsidence profile. If this is not possible, the influence angle can be
approximately set as the complementary angle to the angle of draw.

Supercritical Subsidence Factor Tables
The supercritical subsidence factors used in the calculations are presented in Tables
1.7.1 and 1.7.2.



SDPS Quick Reference Guide, February 2002 21

Percent Hardrock in the Overburden

W/h 10% 20% 30% 40% 50% 60% 70% 80%

0.6 0.52 0.48 0.42 0.35 0.28 0.22 0.17 0.13

0.7 0.57 0.53 0.46 0.38 0.30 0.24 0.19 0.15

0.8 0.60 0.55 0.48 0.40 0.32 0.25 0.19 0.15

0.9 0.61 0.56 0.49 0.41 0.32 0.25 0.20 0.16

1.0 0.62 0.57 0.49 0.41 0.33 0.26 0.20 0.16

1.1 0.62 0.57 0.50 0.41 0.33 0.26 0.20 0.16

1.2 0.63 0.58 0.50 0.42 0.33 0.26 0.20 0.16

1.3 0.63 0.58 0.51 0.42 0.34 0.26 0.20 0.16

1.4 0.64 0.58 0.51 0.42 0.34 0.26 0.21 0.16

1.5 0.64 0.59 0.51 0.42 0.34 0.26 0.21 0.16

1.6 0.64 0.59 0.51 0.42 0.34 0.26 0.21 0.16

1.7 0.64 0.59 0.51 0.43 0.34 0.27 0.21 0.16

1.8 0.64 0.59 0.51 0.43 0.34 0.27 0.21 0.17

1.9 0.64 0.59 0.51 0.43 0.34 0.27 0.21 0.17

2.0 0.64 0.59 0.52 0.43 0.34 0.27 0.21 0.17

Table 1.7.2: Calculation of maximum subsidence factors (Smax/(m R*)) for high extraction
room-and-pillar panels

Horizontal Strain Factor
The value of this factor is directly related to the magnitude of the calculated strains and
curvatures over an undermined area. It can be empirically estimated by the average
ratio of measured strain and curvature over a set of surface points.

The average value determined for the Appalachian coalfields is:

where h is the excavation depth and tan$ is the influence angle. The horizontal strain
factor is expressed in units of length. The horizontal strain coefficient is unitless and its
default value is 0.35.

Note: The higher the value for this coefficient, the larger the predicted strains and
displacements.
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Chapter 2: The Profile Function Method

2.1 Overview of the Profile Function Method
A profile function defines the distribution of subsidence values on the surface along an
axis orthogonal to the boundary of a theoretical, infinitely long, underground excavation
(Figure 2.1.1). In general, a function which is asymptotic to two horizontal lines is
required, and the parameters to be used for this equation must be determined from field
data. The prediction model used in this formulation is based on the hyperbolic tangent
formulation as shown in the equation:
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where:
S(x) = subsidence at x;
x = distance from the inflection point;
Smax = maximum subsidence of the profile;
B = distance from the inflection point to point of Smax; and
c = constant.

This model is sensitive to the maximum subsidence factor for the area (Smax) and the
distance of the inflection point from the rib. The maximum subsidence factor can be
calculated as a function of the percentage of hard material in the overburden (percent
hardrock). The position of the inflection point can be calculated as a function of the
overburden depth. Both estimations are based on statistical procedures used to
evaluate data from Eastern U.S. coalfields and should be used for predicting
subsidence movements over areas with similar characteristics.

In this profile function formulation, the magnitude of the maximum subsidence factor is
not affected by the position of the inflection point. Thus, the same maximum subsidence
factor is obtained using either an average or a conservative estimate of the position of
the inflection point. The position of the inflection point, however, determines the
distribution of the subsidence profile with respect to the rib of the excavation. It should
be emphasized that the profile function developed for this area may not be applicable
for subsidence predictions over other coalfields with different characteristics.

Notes:

• The width-to-depth ratio (W/h) should be greater than 0.5 in order to conform
with the limits of the database used to generate the empirical parameters of this
profile function.

• Due to the mathematical nature of the hyperbolic tangent function, slight
variations in the magnitude of the calculated maximum subsidence value (Smax)
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Figure 2.1.1: Definition of terms used in the profile function method

might occur for different panel widths, under supercritical conditions. In other
words, although the calculated maximum subsidence value should be the same
for supercritical conditions, a slight increase in the value of Smax is observed
with increasing width-to-depth ratio within the supercritical range. Such
variations introduce a margin of error of less than one percent (1%).

• The type of the profile function and its parameters can not be modified by the
user.
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Figure 2.2.1: Profile function input form (part 1)

2.2 Example #1: Calculations Using the
Profile Function Program

Instructions
1. Execute the Profile Function mod-

ule.
2. Select the Edit - Input Parameters

option (Figure 2.2.1).
a. Enter the following parameters:
b. panel type = Longwall
c. panel width = 600 ft
d. panel depth = 500 ft
e. extraction thickness = 5 ft
f. percent hardrock = 50 %
g. surface point spacing = auto-

matic (value of 0)
h. calculation mode = Conserva-

tive
3. Select Conservative Profile as

Prediction Mode.
4. Define “Zero Subsidence” either as

a percent of the calculated maxi-
mum subsidence value for the panel
or as an absolute number (i.e. 0.001
ft or 0.01 m).

5. Click on the “Output Options” tab.
6. Select Display Graph as Results

Mode (Figure 2.2.2).Select Single
Curve as Graph Mode.

7. Select the Display Graph button to
calculate subsidence and plot the
results.

8. The graphing option allows compar-
ison up to 6 graphs. To append
more curves, the user should either
minimize the graph window or move
it to the side to expose the Parame-
ters form. Select Append Curve as
Graph Mode.

9. Click on the “Subsidence Parame-
ters” tab. Select Average Profile as
Prediction Mode.

10. Ensure that more than one curves
are selected in the Graph Options
(see “Setting the Graph Options in
the next Section).

11. Select the Display Graph button to
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Figure 2.2.2: Profile function input form (part 2)

calculate subsidence and plot the
results. Two curves should appear on
the graph. Curve #1 corresponds to the
first curve plotted and Curve #2 to the
second curve plotted. In other words,
blue corresponds to the conservative
calculation and black corresponds to
the average calculation (Figure 2.2.3).
12. Click on the OK button to exit the

input form.
13. Select the File - Save option to

save the input data. Enter EX1 at
the file selection dialog box. The
data should be saved as EX1.PRF.
Select the Save button to save the
data.

14. Select Edit - Project Parameters.
Change the Zero Subsidence
Value to 0.01 ft.

15. Select Conservative Profile as
Prediction Mode.

16. Select Display Graph as Results
Mode.

17. Select Append Curve as Graph
Mode.

18. Select the Display Graph button to
calculate subsidence and plot the
results.

19. Select Average Profile as Predic-
tion Mode.

20. Select the Display Graph button to
calculate subsidence and plot the
results. Two curves should appear
on the graph. Curve #1 corresponds
to the first curve plotted and Curve
#2 to the second curve plotted (Fig-
ure 2.2.4). Compare the graphs on
Figures 2.2.3 and 2.2.4.

21. Exit the program and return to the
calling environment.

Notes:
When a graph has already been cre-
ated with the Plot Angle of Draw op-
tion enabled, then the user can not dis-
able the latter option. This is to avoid
plotting a graph with multiple curves
with and without angle of draw lines. To
change this option, clear the graph first
and then re-plot it.
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Figure 2.2.3: Plot of conservative and average
profile. Also the panel halfwidth and angle of
draw are shown (zero subsidence value =
0.001 ft)

Figure 2.2.4: Plot of conservative and average
profile. Also the panel halfwidth and angle of
draw are shown (zero subsidence value = 0.01
ft)

If the user need to extend the calcula-
tion further out from the angle of draw,
then the spacing of the surface points
should be increased to create more
points on the flat portion of the curve.
This is helpful if the user needs to em-
phasize that a structure lies well outside
of the point of zero subsidence.

Copying a Graph:
The user can copy the graph to any win-
dows word processor that supports clip-
board functions To accomplish this fol-
low these steps:
1. copy the graph to the clipboard us-

ing the Edit - Copy menu option in
the graph form

2. enable the word processing applica-
tion (either launch it or maximize it
from the taskbar)

3. paste the graph in the application
4. save the file for future reference or

report generation
5. add more graphs in the same file

Further Practice:
After completing this original exercise

the user may experiment by changing
the values one at a time to compare the
changes in the curves and the angle of
draw values.

Note for the Novice:
It is a good idea to sketch the mineplan
on a piece of graph paper before using
this program.
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Figure 2.3.1: Graph options for the profile function module

2.3 Example #2: Setting the Basic Graph
Options - Profile Function Method

The user can set some basic graph for-
matting options using the controls in the
form shown in Figure 2.3.1. To show
this form, the user can either click on
the Graph Options button in the Pa-
rameters form (Figure 2.2.1), or click on
the Options - Basic Options menu
item of the graph form (Figures 2.2.2 or
2.2.3).

The parameters included in the Graph
Options form are as follows:

1. The graph title: The graph title is a

text string placed over the graph.
2. The graph x-axis title: The x-axis

title is a text string placed below the
x-axis of the graph.

3. The graph y-axis title: The y-axis
title is a text string placed to the left
of the y-axis of the graph.

4. The grid style: Four grid styles are
available: Horizontal lines, vertical
lines, horizontal and vertical lines,
no grid lines.

5. The graph style: Three graph
styles are available: lines, symbols,
lines and symbols.
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6. When a graph style containing sym-
bols is selected, the user can set
the size of the symbol through the
scroll bar provided.

7. Maximum number of curves: The
user can specify the maximum num-
ber of curves that can be overlaid
on the graph. When this number is
exceeded (in the Append Curve
mode) the program will instruct the
user to clear the graph before pro-
ceeding.

8. Curve legend: This option enables
or disables the legend box in the
graph. When this option is enabled,
the user can set the legend for each
curve in the text box provided. This
text box in not enabled when the
Curve Legend option is disabled.

9. Default parameter options: There

are two default parameter options:
a) to set the default parameters (i.e.
graph title, x-axis title, etc.) every
time the graph options form is
invoked, and b) to set the format
parameters to used in the previous
graphing session. These values are
saved in the PROF.INI file.

Notes:
Similar options appear in the graph
menus of the pillar analysis module as
well as the graph module.

Further Practice
Advanced graph options can be
accessed through the graph tool bar as
explained in Example #3.
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Figure 2.4.1: The Graph Toolbar (to enable the graph toolbar and the advanced graphics
options, click on the Options - Graph ToolBar menu item)

2.4 Example #3: Working with the Advanced
Graphics Options - Profile Function Method

When the graph toolbar is enabled (Fig-
ure 2.4.1), then the user has access to
powerful graphics functions as provided
by the Graphics Server module (version
4.53).

The buttons enabled in the graph tool
bar are follows:
• Data
• Titles
• Axis
• Fonts
• Markers
• Background
• System
• Help
• About

An example of using these advanced
options is given below. In this example,
the user is prompted to change the at-
tributes of certain features of a graph.

A. Changing line attributes:
To accomplish this, click on the Mark-
ers button (the ninth button from the
left, with a green X on it). Then follow
these steps:
T To change the color of individual

lines do the following:
• Move to the box with the line

graphs and use the little arrow
to select a line.

• Move the cursor to the “Color”
box and click on the down ar-
row, scroll down and select the
desired color for the first line.
Go back to the graph lines and
select the same original color
and repeat the color selection.

• Move to the bottom and click on
the Apply Now button. At this
point the color for one set (sub-
sidence curve and angle of
draw lines) has changed.

• Experiment with changing the
color for the other set of lines.

T To change the appearance of the
line other than color, do the follow-
ing.
• In the line box click on Thick

and click on the scroll button.
The second line down is a thin
line. Click on different line val-
ues to determine which is the
best for the current presenta-
tion. Repeat this selection for
each line set. Therefore, it is
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possible to make a distinction
between calculations by using
line width.

• Optionally, select a different line
pattern by clicking on the Pat-
tern box and selecting a differ-
ent line pattern. Once again this
has to be done for each line set.

B. Changing tick marks:
To accomplish this, click on the Axis
button (the sixth button from the left).
Then do the following:
• In the “Tick Mark” box click on mi-

nor.
• In the “Apply to Axis box” click on “Y

Primary” or “X” to apply the tick
marks to the graph.

• Click on Apply Now to modify the
graph.

Note that the user can define the spac-
ing of the secondary ticks. Spacing of
primary ticks is automatically adjusted
by the Graphics Server object.

C. Print the graph:
To accomplish this, click on the Sys-
tems button (the fourth button from the
right). Then do the following:
• Under printing click on “color” (for

color plots).
• Click on Print to send the graph

directly to the default Windows
printer.

D. Changing the background:
To accomplish this, click on the Back-
ground button (the fifth button from the
right). In this menu you can select differ-
ent colors for different parts of the

graph. Optionally, select the position of
the different parts of the graph.

E. Changing the fonts:
To accomplish this, click on the Fonts
button (the eighth button from the left).
In this menu the user can select differ-
ent typeface types, as well as character
size for each of the different parts of the
graph.

Notes:

The graph template provided by the
Graphics Server Object is a function
that allows the user to save a custom
set of settings, e.g. color, fonts, etc.,
and recall that template every time that
is needed. To accomplish this, make all
necessary formatting changes to a
graph, and then click on the System
button. Enter a name in the Graph
Template File name text box and click
on Save. To restore settings saved in a
graph template, create the graph, click
on the System button, enter the file
name of the graph template in the ap-
propriate box and click on Load.

Further instruction on the Graphics
Server Object:

Click on the Help (?) button of the graph
toolbar and follow the prompts.
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Chapter 3: The Influence Function
Method

3.1 Overview of the Influence Function
Method
Influence function methods for subsidence prediction have the ability to consider any
mining geometry, to negotiate superposition of the influence from a number of
excavated areas having different mining characteristics and, also, to calculate
horizontal strains as well as other related deformation indices. The function utilized in
SDPS is the bell-shaped Gaussian function. This method assumes that the influence
function for the two-dimensional case is given by:
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where:
r = the radius of principal influence = h / tan(beta);
h = the overburden depth;
beta = the angle of principal influence;
s = coordinate of the point P, where subsidence is considered;
x = coordinate of the infinitesimal excavated element; and
So(x) = convergence of the roof of the infinitesimal excavated element.

Subsidence at any point P(s), therefore, can be expressed by the following equation:

S x s
r

s x
x r

ro( , ) ( ) exp
( )

= −
−









−∞

+∞

∫
1 2

2π

where:
So(x) = m(x) a(x);
m(s) = extraction thickness; and
a(x) = roof convergence (subsidence) factor.

The influence function formulation can thus be applied to calculate surface
deformations (subsidence, strain, slope, curvature, displacements) above longwall and
room-and-pillar panels, given the geometry of the excavation, information on the
overburden geology, as well as the location of the prediction points on the surface.
More specifically, the required data include:
• the geometry of the mine plan and the associated properties (extraction

thickness, subsidence factor for supercritical conditions)
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• the location (coordinates) of the points on the surface for which prediction of the
deformation indices (subsidence, strain, slope, curvature, horizontal
displacement) is to be performed

• the empirical parameters that numerically represent the behavior of the
overburden

The typical steps required to calculate surface deformations using the influence
function method, are shown below. The corresponding flowchart is also shown in
Figure 3.1.1. Figure 3.1.2 presents a schematic diagram for creating the input data.
Figure 3.1.3 presents typical distributions for the deformation indices that can be
calculated by the influence function method. Table 3.1.1 shows all the indices that can
be calculated by the influence function method.

T Load the Influence Function Program
T Input Data
T Mine Plan Data

• Prediction Point Data
• Empirical Parameters

T Select calculation options
• Subsidence
• Horizontal Strain
• Horizontal Displacement
• Slope
• Curvature

T Save Project File
T Calculate Surface Deformations
T Load Graphing Program
T View Calculated Deformations
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Simplified Mine Plan: Rectangular
Panels and Surface Points on a Grid

using a Local Coordinate System

Decide on the type of Analysis:
Simplified or Actual Mine Plans

Actual Mine Plan: Polygonal Panels
and Scattered Surface Points using a

World (Global) Coordinate System

Prepare Mine Plan and Prediction
Points in AutoCad (or other CAD
package). Place similar entities in

separate layers.

Enter data manually

Is CAD package AutoCad
2000 or higher ?

Import directly
into SDPS

Export to DXF. Import
DXF file to SDPS

Adjust Subsidence Parameters based
on regional data or calibration

Save Project File

Run Calculation

View Results and Graph Deformations

Change Subsidence
Parameters or Geometry ?

End

Start

no yes

no

yes yes

Calibration
Data

Figure 3.1.1: Flowchart diagram for using the influence function module
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Figure 3.1.2: Steps in defining a project file
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Figure 3.1.3: Typical deformation
distributions
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Number Deformation Index Name Code Units

1 Subsidence SU ft or m

2 Slope in the X-direction TX %

3 Slope in the Y-direction TY %

4 Directional Slope TA %

5 Maximum (Total) Slope TM %

6 Angle1 of Maximum Slope TE deg

7 Horizontal Displacement in the X-direction VX ft or m

8 Horizontal Displacement in the Y-direction VY ft or m

9 Directional Horizontal Displacement VA ft or m

10 Maximum (Total) Horizontal Displacement VM ft or m

11 Angle1 of Maximum Horizontal Displacement VE deg

12 Curvature in the X-direction KX 1/ft or 1/m 2

13 Curvature in the Y-direction KY 1/ft or 1/m 2

14 Directional Curvature KA 1/ft or 1/m 2

15 Maximum Principal Curvature K1 1/ft or 1/m 2

16 Minimum Principal Curvature K2 1/ft or 1/m 2

17 Maximum Curvature KM 1/ft or 1/m 2

18 Angle1 of Maximum Principal Curvature KE deg

19 Horizontal Strain in the X-direction EX - 3

20 Horizontal Strain in the Y-direction EY - 3

21 Directional Horizontal Strain EA - 3

22 Maximum Strain EM - 3

23 Maximum Principal Strain E1 - 3

24 Minimum Principal Strain E2 - 3

25 Angle1 of Maximum Principal Strain EE deg
1 This angle is calculated in degrees from the positive x-axis in a counter-clockwise

direction. It gives the direction of the maximum value of the corresponding index on the x-
y plane.

2 expressed in tenths of ppm (divide by 10.000 to obtain result)
3 expressed in millistrains (divide by 1000 to obtain result)

Table 3.1.1: Identification codes for deformation indices
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3.2 Definition of the Mine Plan in the
Influence Function Program
Mine plan data describe the extraction area under consideration using various
conventions. An extraction area is always defined in three-dimensional space by
specifying the X,Y,Z coordinates of the points defining that area. Mine panels and
pillars are referred to as excavation parcels. A parcel can be either active or not active.
A parcel, which is not active, is not deleted from the file, but it does not participate in
the calculations.

Geometry and Boundary Adjustment:

The geometry of a mine plan is determined by the geometry of the excavation panels
adjusted by the edge effect. This parameter represents the distance between the
actual rib of the excavation and the position of the inflection point, as determined by
panel geometry and site characteristics. The location of the inflection point, which
defines the transition between horizontal tensile and compressive strain zones, is very
important for the application of the influence function method. The distance of the
inflection point from the rib using either an average and a conservative estimate as a
function of the width-to-depth ratio of a panel can be estimated using this graph.

Thus, the magnitude of the edge effect can be determined as follows:
T from the graph estimating the location of the inflection point for the conservative

or average estimate (Figure 3.1.1),
T by clicking on the Subs.Parm button in the rectangular mine plan form of the

influence function program,
T by analyzing subsidence curves measured at a specific site or region.

Panel Representation:

T Simple mine layouts can usually be approximated using sets of rectangular
extraction areas. In this case, the input required for every parcel includes the
parcel number; the coordinates of the west, east, south, and north borders; the
seam elevation; the extraction thickness (mining height); and the average
supercritical subsidence factor (in percent) associated with it. These coordinates
can be specified in a local or a global coordinate system with axes parallel to the
parcel sides. In the Influence function module, this option is implemented as
Rectangular Mine Plans.

T Complex mine layouts can usually be approximated by a closed polygon (i.e. a
piece-wise linear shape). In this case, the input required for every point within a
parcel includes the point reference number; the northing (Y), easting (X), and
elevation (Z); the extraction thickness (mining height); and the supercritical
subsidence factor (in percent) associated with it. The mine plan editor can
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provide access to all points in a parcel, add new points, and add new parcels
provided that the current parcel is defined by three or more points. The points
should be entered in a counter-clockwise fashion. The location of each point
should be adjusted to reflect the edge effect, or the relative position of the
inflection point. The maximum number of parcels and points per parcel can be
adjusted within the limits of the available memory. In the Influence function
module, this option is implemented as Polygonal Mine Plans.

Warning:

Pillars can not exist outside extracted areas. If a pillar is defined outside an extracted
area the results are unpredictable. Currently, the parcel definition module of the
program can not check for such inconsistencies. Examples of erroneous panel
definitions are given in Appendix 3.

Notes:

T If no adjustments are made to the geometry of the mine plan, the program
assumes that the inflection point is over the rib of the excavation.

T The user must specify whether each parcel represents an extracted panel or a
pillar within an extracted panel. A pillar is mathematically represented as a
parcel with a negative subsidence factor. Setting the pillar option on a parcel
will reset the subsidence factor associated with this parcel. In that sense, an
extraction area can be either positive (i.e. longwall panel) or negative (i.e. pillar
in the middle of a panel). Thus, a mine plan that consists only of pillars (without
an extraction boundary) will produce a mathematically positive! subsidence.

T It should be emphasized that the subsidence factor used here is the subsidence
factor for supercritical conditions.

T The reason for supporting more than one format for input data is for the user's
convenience. For example, certain panels or pillars can be easily represented
as rectangles and can be entered as single entities, compared to four or more
entries required if these panels are digitized point by point. Additionally,
calculations for rectangular parcels are much faster compared to calculations for
parcels defined by individual points.
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Figure 3.2.1: Determination of the offset of the inflection point.
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3.3 Definition of the Prediction Points in the
Influence Function Program
Prediction point data describe the surface points where the deformation indices will be
calculated. Prediction points are always defined in three-dimensional space, by
specifying the X,Y,Z coordinates of these points. A point can be either active or not
active. A point which is not active is not deleted from the file but will not be included in
the calculations.

Scattered Points

A scattered point set may consist of any number of points that are randomly located on
the surface. If such points can be specified as part of a grid, then the Grid Points
option should be used. Required parameters for each point include:

T the point reference code which can be any alphanumeric string,
T the easting, northing and elevation of each point,
T the point status, i.e. active or not active (an inactive point will not be displayed in

the View option and will not participate in any of the calculations)

Grid Points

A grid point set may consist of any number of points in a window. This window is
defined by minima and maxima in the X- and Y- directions as well as the cell size in
each direction.

The grid can only be oriented parallel to the current coordinate system. If the grid
needs to be oriented at an angle to the current coordinate system, the grid points
should be generated by a different tool and imported as scattered points into the
Influence Function module.

The user has two options regarding grid elevations.
T to consider a flat surface and specify a uniform elevation for all points, and
T to consider each point on an individual basis and specify individual point

elevations.
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Figure 3.4.1: Project description form

3.4 Example #4: Calculations Using the
Influence Function Program - Deformations
on a Transverse Line

Instructions
1. Execute the Influence Function

module.
2. Select the Edit - Project

Description option (Figure 3.4.1).
3. Enter the following parameters:

• rectangular mine plan
• grid points
• angle of influence = 2.31
• strain coefficient = 0.35
• percent hardrock = 50%

4. Click on the OK button to exit the
input form.

5. Select the Edit - MinePlan option

(Figure 3.4.2).
6. Enter the following parameters:

• parcel number = 1.01
(automatic)

• west border = -300 ft
• east border = +300 ft
• south border = -1000 ft
• north border = +1000 ft
• seam elevation = 0 ft
• extraction thickness = 6 ft
• supercrit. subs. factor = 39.5 %

(automatic)
• parcel status = active panel
• adjustments = do not adjust
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Figure 3.4.2: Rectangular mine plan input form

Figure 3.4.3: Grid point input form
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Figure 3.4.4: Output options form

Example 4 Instructions (continued)

7. Click on the View button to view the
mine plan.

8. Close the viewing window.
9. Click on the Close button to exit the

input form.
10. Select the Edit - Prediction Points

option (Figure 3.4.3).
11. Enter the following parameters:

• minimum easting = -700 ft
• maximum easting = +700 ft
• cell size in the x-direction= 50 ft
• minimum northing = 0 ft
• maximum northing = 0 ft
• cell size in the y-direction = 0 ft
• average elevation = 500 ft

12. Select the View-All button to view
the mine plan and points.

13. Close the viewing window.

14. Select the Close button to accept
the data.

15. Select the Calculate - Calculate
Deformation menu item (Figure
3.4.4).

16. Enter EX2 for the file prefix code
and check the options shown in Fig-
ure 3.4.4. Click on OK to accept the
data.

17. Leave the remaining options at their
default values.

18. Click on the “Calculate” command
button.

19. The model will be solved. Close the
solution module monitor form.

20. Select the Graph option.
21. In the graph module, select the 2-D

option (Figure 3.4.5).
22. Select the appropriate cross-section

(X or Y).
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Figure 3.4.5: Graph module, 2D graph options

23. Select the index to view and click on
the Graph button. A 2-D graph of
the selected deformation index will
be plotted on the screen.

24. If the option Set default format pa-
rameters is enabled, then all graph
options will be locked. By selecting
the Set format parameters to last
used option, the user can modify
current graph settings.

Further Practice:

After completing this original exercise
the user may experiment by changing
the values one at a time to compare the
changes in the curves.

Note for the Novice:

It is a good idea to sketch the mineplan
and surface points on a piece of graph
paper before using this program.
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3.5 Example #5: Calculations Using the
Influence Function Program - Adjusting the
Panel Boundaries

Figure 3.5.1: Subsidence parameters

Example 5 Instructions
1. Execute the Influence Function

module.
2. Repeat steps 2 - 5 of example #4.
3. Enter the following parameters:

• parcel number = 1.01
(automatic)

• west border = -300 ft
• east border = +300 ft
• south border = -1000 ft
• north border = +1000 ft
• seam elevation = 0 ft
• extraction thickness = 6 ft
• supercrit. subs. factor = 40 %
• parcel status = active panel
• adjustments = auto adjust

4. Click on the Subs. Parm button
(Figure 3.5.1).

5. The form shown in Figure 3.5.1 al-
lows the user to “adjust” panel
boundaries, depending on the
boundary conditions of each panel.
Also, the supercritical subsidence
factor may be adjusted.

6. There are three Adjustment Op-
tions.

7. Selecting Do not adjust will disable
any adjustments to the geometry of
the panel or the supercritical
subsidence factor. The original val-
ues set in the form as the one
shown in Figure 3.4.2 will be used
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for the calculations.
8. Selecting Manual adjust, the pro-

gram allows the user to enter
specific (measured or other) values
in the fields to the right of the origi-
nal panel coordinates and the origi-
nal supercritical subsidence factor.
The manually adjusted values will
be used in the calculations.

9. Selecting Automatic adjust, the
program automatically calculates
the necessary adjustments based
on the input in this form (Figure
3.5.1). Such input includes the type
of the subsidence estimate, the per-
cent hardrock, the panel depth, etc.
The automatically adjusted values
will be used in the calculations.

10. In case the user wishes to start from
the automatically calculated adjust-
ments and update them to reflect
current mining conditions, then
Automatic adjustment should be
selected in this form to calculate the

default values and then Manual ad-
justment should be selected to dis-
able any further changes to these
values.

Notes:
• Under yielding boundary

conditions, the boundary is not
adjusted.

• The original (geometric) boundaries
are kept and displayed when view-
ing the panel.

• Adjustments are not allowed for pil-
lars.

• Adjustments are not available in
polygonal mine plans.

Further Practice:
After completing this original exercise
the user may experiment by changing
the values one at a time to compare the
changes in the curves.
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3.6 Example #6: Calculations Using the
Influence Function Program - Deformations
Around a Panel Edge

Figure 3.6.1: Grid point input form
Instructions
1. Execute the Influence Function

module.
2. Repeat steps 2 - 9 of example #4.
3. Select the Edit - Prediction Points

option (Figure 3.6.1).
4. Enter the following parameters:

• minimum easting = -700 ft
• maximum easting = +700 ft
• cell size in the x-direction = 50ft
• minimum northing = -1500 ft
• maximum northing = 50 ft
• cell size in the y-direction = 50ft
• average elevation = 500 ft

5. Select the View All button to view
the mine plan and prediction points

6. Close the viewing window.
7. Select the Close button to accept

the data.
8. Select the Calculate - Output Op-

tions menu item.
9. Enter EX4 for the file prefix code

and check the options shown in Fig-
ure 3.6.2. Click on OK to accept the
data.

10. Select the File - Save Project op-
tion

11. Save the project.
12. Select the Calculate - Calculate

Deformations option
13. The model will be solved. Close the

solution module monitor form.
14. Select the Graph option.
15. In the graph module, select 2-D op-

tion.
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Figure 3.6.2: Transverse subsidence profile

16. Select the index to view and click on
the Graph button. You may select a
certain section along the X or Y axis
to view. A 2D graph of the selected
deformation index will be plotted on
the screen (Figure 3.6.2). Clicking
on the +plane -plane buttons plots
of the previous or following sections
may be overlaid on the current

graph.
17. Close the plot window.
18. Select the 3-D option.
19. Select the index to view and click on

the Graph button. A 3D graph of the
selected deformation index will be
plotted on the screen.
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Figure 3.7.1: Mine plan and prediction
points

3.7 Example #7: Calculations Using the
Influence Function Program - Deformations
over Two Longwall Panels

Instructions
1. Execute the Influence Function

module.
2. Select the Edit - Project

Description option.
3. Enter the following parameters:
4. rectangular mine plan

• grid points
• angle of Influence = 2.31
• strain coefficient = 0.35
• percent hardrock = 50%

5. Click on the Close button to exit the

input form.
6. Select the Edit - MinePlan option

and enter the coordinates for the
first panel (dimensions = 600 x 4000
ft, elevation = 0 ft, extraction thick-
ness = 6 ft)
• parcel number = 1.01 (auto-

matic)
• west border = -300 ft
• east border = +300 ft
• south border = -2000 ft
• north border = +2000 ft
• seam elevation = 0 ft
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• extraction thickness = 6 ft
• supercrit. subs. factor = 39.5 %

(automatic)
• parcel status = active panel
• adjustments = do not adjust

7. Click on Append in the Insert
Mode frame. This changes the Ins
Parcel button to App Parcel (if not
already changed). Click on the App
Parcel button (Append mode is en-
abled if the Append Mode button is
selected).

8. Enter the coordinates for the sec-
ond panel (dimensions 600 x 4000
ft) at a horizontal offset of 200 ft:
• parcel number = 2.02

(automatic)
• west border = 500 ft
• east border = 1100 ft
• south border = -2000 ft
• north border = +2000 ft
• seam elevation = 0 ft
• extraction thickness = 6 ft
• supercrit. subs. factor = 39.5 %

(automatic)
• parcel status = active panel
• adjustments = do not adjust

9. Click on the Close button to exit the
input form.

10. Select the Edit - Prediction Points
option.

11. Enter the coordinates for the grid
points (to cover the south panel
edge of both panels) as follows:
• minimum easting = -700 ft
• maximum easting = +1500 ft
• cell size in the x-direction = 100

ft
• minimum northing = -2500 ft
• maximum northing = -1200 ft

• cell size in the y-direction = 100
ft

• average elevation = 500 ft
12. Select the View-All button to view

the mine plan and points (Figure
3.7.1).

13. Close the viewing window.
14. Click on the Close button to accept

the data.
15. Select the Calculate - Output Op-

tions menu item.
16. Enter EX5 for the file prefix code

and check the options shown in Fig-
ure 3.4.4. Select OK to accept the
data.

17. Select the File - Save Project op-
tion.

18. Save the project.
19. Select the Calculate - Calculate

Deformations option.
20. The model will be solved. Close the

solution module monitor form.
21. Select the Graph option.
22. In the graph module, select the 3-D

option.
23. Select the index to view and click on

the Graph button. A 3D graph of the
selected deformation index will be
plotted on the screen (Figure 3.7.2).

Further Practice:

After completing this original exercise
the user may experiment by changing
the values one at a time to compare the
changes in the curves.
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Figure 3.7.2: 3-D image of subsidence over the longwall panels
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Overburden depth 600 ft Edge effect None
Extraction ratio 90 % Tangent of influence angle 2.31
Extraction thickness 6 ft Strain coefficient 0.35
Percent hardrock 50 %

Table 3.8.1: Input parameters for example #8

3.8 Example #8: Calculations Using the
Influence Function Program - Deformations
over a Room-and-Pillar Section with a
Remnant Stable Pillar

1. Execute the Influence Function
module.

2. Select the Edit - Project Descrip-
tion option.

3. Enter the following parameters:
• rectangular mine plan
• points on a grid
• angle of influence = 2.31
• strain coefficient = 0.35
• percent hardrock = 50%

4. Click on the OK button to exit the
input form.

5. Select the Edit - MinePlan option.
6. Enter the coordinates for the first

panel:
• dimensions = 600 x 400 ft
• elevation = 0 ft
• supercrit.subs fact = 34% (*)
• extraction thickness = 6 ft
• adjustment = do not adjust
• panel type = parcel

7. Click on the R&P Panel check box.
This indicates that the panel is a
room-and-pillar panel and, thus, the
supercritical subsidence factor
should be automatically calculated
accordingly. This option should not
be confused with the panel and pil-
lar designation of each parcel. The

latter is adjusted in the Parcel Type
frame of the form.

8. Click on Append in the Insert Mode
frame. This changes the Ins Parcel
button to App Parcel (if not already
changed). Click on the App Parcel
button.

9. Enter the coordinates for the sec-
ond parcel (pillar):
• dimensions = 150 x 100 ft
• elevation = 0 ft
• supercrit.subs fact = 34% (*)
• extraction thickness = 6 ft
• adjustment = do not adjust
• parcel type = pillar
Note that the user is free to select
the exact location of the pillar. This
is to further acquaint the user with
parametric analysis of the influence
of underground workings on the
surface.

10. Select the View button to view the
mine plan (Figure 3.8.1).

11. Close the viewing window.
12. Click on the Close button to exit the

input form.
13. Select the Edit - Prediction Points

option.
14. Enter the following parameters:
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Figure 3.8.1: Mine plan and prediction points

• grid cell size = 50 ft
• average elevation = 400 ft

15. Click on the View-All button to view
the mine plan and points (Figure
3.8.1).

16. Close the viewing window.
17. Click on the Close button to accept

the data.
18. Select the Calculate - Output Op-

tions menu item.
19. Check the appropriate options and

select OK to accept the data.
20. Select the File - Save Project op-

tion.
21. Save the project.
22. Select the Calculate - Calculate

Deformations option.

23. The model will be solved. Close the
solution module monitor form.

24. Select the Graph option.
25. In the graph module, select the 2-D

option.
26. Select the index to view and click on

the Graph button. A 2-D graph of
the selected deformation index will
be plotted on the screen.

(*) Check subsidence tables
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Figure 3.9.1: Mine plan
and prediction points

Easting (x) northing (y) elevation (z)
0 4200 610

100 4100 620
200 4000 630
300 3900 640
400 3800 650
500 3700 660
... ... ...

Table 3.9.1: Coordinates of prediction points

3.9 Example #9: Calculations Using the
Influence Function Program - Strains on
Pipeline over a Longwall Panel

Instructions
1. Execute the Influence Function

module.

2. Select the Edit - Project Descrip-
tion option.

3. Enter the following parameters:
• rectangular mine plan
• scattered points
• angle of influence = 2.31
• strain coefficient = 0.35
• percent hardrock = 50%

4. Click on the OK button to exit the
input form.

5. Select the Edit - MinePlan option.
6. Enter the coordinates for the panel:

• dimensions = 600 x 4000 ft
• elevation = 0 ft
• supercrit.subs fact = 40% (*)
• extraction thickness = 6 ft
• adjustment = do not adjust

7. Click on the View button to view the
mine plan (Figure 3.9.1).

8. Close the viewing window.
9. Click on the Close button to exit the

input form.
10. Select the Edit - Prediction Points

option.
11. Enter the parameters for the predic-

tion points as shown in Table 3.9.1.
(these are scattered points over the
edge of the panel).
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Surface Deformations
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Figure 3.9.2: Directional strain on the pipeline

12. Click on the View-All button to view
the mine plan and points (Figure
3.9.1).

13. Close the viewing window.
14. Click on the Close button to accept

the data.
15. Select the Calculate - Output Op-

tions menu item.
16. Check the appropriate options in-

cluding the options for axial (direc-
tional) strain and select OK to ac-
cept the data.

17. Select the File - Save Project op-
tion.

18. Save the project.

19. Select the Calculate - Calculate
Deformations option.

20. The model will be solved. Close the
solution module monitor form.

21. Select the Graph option.
22. In the graph module, select the 2-D

option.
23. Select the Ea index (directional

strain) to view and click on the
Graph button. A 2-D graph of the
selected deformation index will be
plotted on the screen (Figure 3.9.2).
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Figure 3.10.1: Mine plan and
prediction points

3.10 Example #10: Calculations Using the
Influence Function Program - Deformations
due to Multiple Seam Mining

Instructions
1. Execute the Influence Function

module.
2. Use default subsidence parameters

and influence angle
3. Define two rectangular parcels of

600 x 2000 ft.
4. Position parcels so that they over-

lap horizontally by 300 ft (Figure
3.10.1).

5. Define the elevation of the bottom

parcel as 0 ft.
6. Define the elevation of the top par-

cel as 200 ft.
7. Define the prediction point datum at

+600 ft.
8. Define a grid of points overlapping

both parcels with a cell size of 50 ft.
9. Save the project and calculate de-

formations.
10. Graph deformation indices.
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Figure 3.11.1: Mine plan and prediction points

3.11 Example #11: Calculations Using the
Influence Function Program - Deformations
on a line over a Room & Pillar Section

Instructions
(In this example it is assumed that the
user is familiar with AutoCAD functions.)
1. Digitize the mine plan and surface

points in AutoCAD. Digitize the pil-
lars and panel boundaries as poly-
lines. Place all pillars in layer PIL-
LARS, the panel boundary in layer
PANELS and the surface points in
layer POINTS. Elevations for all
entities may be entered. Also,
please note that it is recommended
that all polylines are digitized in a
counter-clockwise fashion. Export
all entities in DXF format. Exit
AutoCAD.

2. Execute the Influence Function
module.

3. Use default subsidence parameters
and influence angle.

4. Select the File - Import SDPS
Components option. Import the
mine plan and prediction points in
two steps (Figure 3.11.2). Ensure
that default layer values for pillars,
panels and points are PILLARS,
PANELS and POINTS respectively.

5. Select the Edit - Mine Plan option
and View the mine plan and predic-
tion points (Figure 3.11.1).

6. Select the Calculate - Output Op-
tions menu item.

7. Check the appropriate options and
click on OK to accept the data.

8. Select the File - Save Project op-
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Figure 3.11.2: Import form

tion.
9. Save the project.
10. Select the Calculate - Calculate

Deformations option.
11. Allow the program to check the

model for clockwise parcels. The
model will be solved. Close the so-
lution module monitor form.

12. Select the Graph option and view
the graphs.

Optionally, the user can import the pan-
els and points directly from the
AutoCAD DWG file. For this option to

work, AutoCAD 2000 or higher should
be installed on the same computer as
SDPS. To accomplish this, follow these
steps:
1. Select the File - Import SDPS com-

ponents option. Select the
“AutoCAD DWG” tab and click on
“Import from AutoCAD”. Specify the
name for the DWG file and select
the layer names for panels, pillars
and points.

2. When the mine plan and prediction
points have been imported go to
step 5 above.
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Figure 3.12.1: Mine Plan

3.12 Example #12: Calculations Using the
Influence Function Program - Deformations
over a Room & Pillar Section Using Data
from AutoCAD / SurvCADD

Instructions
(In this example it is assumed that the
user is familiar with AutoCAD and
SurvCADD functions.)

1. Digitize the mine plan in AutoCAD.
Digitize the pillars and panel
boundaries as polylines. Place all
pillars in layer PILLARS, the panel
boundaries in layer PANELS and
the surface points in layer POINTS.
Elevations for all entities may be
entered. Also, please note that it is
recommended that all polylines are
digitized in a counter-clockwise
fashion. Export all entities in DXF
format.

2. Load the surface contour lines

(surface topography) in AutoCAD.
3. Create a 3D grid in SurvCADD and

save to a file (*.GRD).
4. Exit AutoCAD.
5. Execute the Influence Function

module.
6. Select the File - Import SDPS

Components option. Import the
mine plan. Ensure that default layer
values for pillars and panels are
PILLARS and PANELS respectively.

7. Import the prediction points from the
SurvCADD grid file. This is an one-
step procedure and no parameters
are needed (Figure 3.12.2).

8. Select the Edit - Mine Plan option
and View the mine plan (Figure
3.12.1) and prediction points
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Figure 3.12.2: Importing prediction points from SurvCADD

(Figure 3.12.3). Note that the
mineplan shown in Figure 3.12.1. is
incomplete in the sense that the
bounding line for the pillars is
missing.

9. Select the Edit - Prediction Points
option and click on the Table button
to see the data in speadsheet
format (Figure 3.12.4) and verify
that prediction point elevations are
imported properly.

10. Select the Calculate - Output
Options menu item.

11. Check the appropriate options and
click on OK to accept the data.

12. Select the File - Save Project
option.

13. Save the project.
14. Select the Calculate - Calculate

Deformations option.
15. Allow the program to check the

model for clockwise parcels. The
model will be solved. Close the
solution module monitor form.

16. Select the Graph option and view
the graphs.
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Figure 3.12.4: Editing the surface prediction points in the sheet editor

Figure 3.12.3: Partial plan view of mineplan and prediction points
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3.13 Example #13: Calculations Using the
Influence Function Program - Develop Site
Specific Subsidence Predictions Using
Known Field Data
Instructions
1. Execute the Influence Function

module.
2. Select the Edit - Project Descrip-

tion option.
3. Enter the following parameters:

• polygonal mine plan
• scattered points

4. Click on the OK button to exit the
input form.

5. Select the Utilities - Options func-
tion.

6. Enable the Calibration Feature (if
not already enabled).

7. Define the mine plan.
8. Define the prediction points. Enter

the measured subsidence value
for every point.

9. Select the Calculate - Calibration
Options function (Figure 3.13.1-2).

10. Select the range for the tangent of
the influence angle, the range of the
subsidence factor, and the range for

the edge effect. Note that the edge
effect applies to all sides of a polyg-
onal panel.

11. Save the project.
12. Select the Calculate - Calibrate

Influence Function option.
13. The solution module will invoked

and the values of the tangent of the
influence angle and of the subsi-
dence factor will be calculated for
all cases. The values that minimize
the total error between the predicted
and measured subsidence values
will be suggested as the site spe-
cific values.

14. The user has the option to Graph
the measured and predicted subsi-
dence values and visually inspect
the match. Also, the user can print
summary and detailed reports for
the calibration procedure.
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Figure 3.13.1: Calibration options

Figure 3.13.2: Calibration options
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Figure 3.14.1: Mine Plan and Parcel Layout, Example #14

3.14 Example #14: Site Specific Parameters
for a Room-and-Pillar Case Study - Influence
Function method
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Description
This example represents an actual room-and-pillar case study monitored by Virginia
Polytechnic Institute and State University, identified as RUVAVT2. It was selected due
to its complicated mining geometry and unique, as well as highly variable, mining and
geological parameters. In this particular mine, the amount of hardrock ranged from
40% to 80%, the overburden was extremely shallow (average depth 365 feet), and the
extraction method produced a highly irregular excavation geometry, since pillars were
often left in place in order to combat ground control problems.

Subsidence predictions for such a case study, using a general method based on
average field values, will not yield accurate results. However, the prediction methods
can be modified by adjusting the empirical parameters used to calculate subsidence
and strain so that the predicted profiles are forced to fit the measured profiles (VPI&SU
1987). Thus, the general prediction method can be transformed to a site-specific
prediction model for a particular case study. This was accomplished by applying the
influence function method and employing a trial and error procedure in order to
calculate the values for the tangent of the influence angle and the strain coefficient for
the particular case study. The input parameters shown in Table 3.14.1 correspond to
those that produced the best match between measured and calculated subsidence and
strain profiles.

Parameters
The mine plan for this case study is shown in Figure 3.14.1. Before entering the mine
plan data into the influence function program, a decision was made with respect to the
most appropriate method to represent the mine plan in a digital form. Since the mine
plan could be divided into areas of relatively uniform extraction, it was decided that it
would be much quicker, without loss of accuracy in the predictions, to represent the
mine plan as a set of six (6) parcels. Three (1-3) of these represent extracted areas,
while the remaining three (4-6) represent pillars or pillar areas. Using this procedure,
one can avoid entering the coordinates of each individual pillar into the mine plan.
Once the excavated area was identified on the mine map, the outer boundaries of that
area were modified by the edge effect before the parcel coordinates were entered into
the program. The mine plan points, prediction point data, and the empirical parameters
used in this example are summarized in Table 3.14.1.

The empirical parameters for this example were obtained as follows:
• The edge effect was calculated using the conservative line of Figure 3.2.1 for

W/h = 1.2. Thus d = 0.2 x 365 = 73ft.
• The default value for the tangent of the influence angle was selected as the

initial value. The influence function program was executed and the predicted
subsidence values were compared to the measured data. Subsequently, the
initial value was modified until a satisfactory match between the measured and
predicted subsidence values was obtained.

• The default value for the strain coefficient was selected as the initial value. The
influence function program was executed and the predicted strain values were
compared to the measured data. Subsequently, the initial value was modified



SDPS Quick Reference Guide, February 2002 66

until a satisfactory match between the measured and predicted strain values was
obtained.

• The subsidence factors were calculated as follows:
• 40%HR, high extraction room-and-pillar => subs.factor = 42%
• 40%HR, 70% extraction room-and-pillar => subs.factor = 42%*0.7 = 29%
• 40%HR, 50% extraction room-and-pillar => subs.factor = 42%*0.5 = 21%

Notes:
• The edge effect value was not modified, since a good match was obtained by

manipulating the influence angle. In other case studies, manipulation of the edge
effect may be necessary.

• The extraction ratios given for each parcel are the average ratios measured for
the corresponding parcels.

• The subsidence factors for pillars are negative values and are calculated as a
percentage of the supercritical subsidence factor based on the remaining portion
of the pillar.

The mine plan and prediction point coordinates are detailed in Tables 3.14.1, 3.14.2
and 3.14.3. Note that all coordinates are given in feet.

The influence function program was setup for polygonal parcels and points on a grid.
For simplicity a local coordinate system was selected with the origin in the middle of the
panel. Figure 3.14.2 compares the fitted and measured subsidence profiles, while
Figure 3.14.3 compares the fitted and measured strain profiles, in the transverse
direction. Figures 3.14.4 and 3.14.5 show corresponding comparisons in the
longitudinal direction. Figure 3.14.6 presents subsidence contours over the affected
area, while Figure 3.14.7 presents a three-dimensional projection of the subsidence
trough over that area. Figure 3.14.8 presents the corresponding strain contours.

Notes:
• Subsidence and maximum strain contouring was accomplished using third party

contouring packages.
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Excavation
Parcel

No. of
Data

Points

Smax

[ft]

Elevation

[ft]

Extraction
Thickness

[ft]

Extraction
Ratio
[%]

Subsid.
Factor

[%]

1 32 2.10 2,400 5 85% 42

2 6 1.85 2,400 5 70% 29

3 8 1.05 2,400 5 50% 21

4 * 10 1.85 2,400 5 70% !13

5 * 4 0 2,400 5 0 !42

6 * 4 0 2,400 5 0 !42

(*) Negative subsidence factors describe the effect of the remnant pillars. In the
program, positive subsidence factors are entered and the pillar option is enabled.

Grid Parameters of
Prediction Points

Value Empirical Parameters Value

Minimum easting [ft] !900 Tangent of influence angle 4.29

Maximum easting [ft] 1200 Strain coefficient 0.12

Cell size in X-direction [ft] 50 Edge effect, conservative
estimate [ft]

73

Minimum northing [ft] !900

Maximum northing [ft] 400

Cell size in Y-direction [ft] 50

Avg surface elevation [ft] 2765

Table 3.14.1: Input parameters for example #14
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[MINE PLAN DATA]
[Polygonal Mine Plan]
Total Parcels: 6
Parcel No: 1 -> Points: 32 Status: Active Panel
Point No Easting Northing Seam Extraction Subs.

Elevation Thickness Factor
3.000 806.54 -258.31 2425.00 5.00 42.00
4.000 637.79 -159.98 2415.00 5.00 42.00
5.000 486.75 64.68 2405.00 5.00 42.00
6.000 487.98 163.35 2400.00 5.00 42.00
7.000 392.82 167.22 2400.00 5.00 42.00
8.000 391.41 139.84 2400.00 5.00 42.00
9.000 133.76 89.74 2390.00 5.00 42.00
10.000 130.54 175.49 2390.00 5.00 42.00
11.000 -286.65 183.04 2380.00 5.00 42.00
12.000 -290.27 123.51 2380.00 5.00 42.00
13.000 -360.26 120.56 2380.00 5.00 42.00
14.000 -360.31 -89.85 2380.00 5.00 42.00
15.000 -295.96 -92.80 2380.00 5.00 42.00
16.000 -286.92 -650.15 2390.00 5.00 42.00
17.000 -214.77 -653.62 2390.00 5.00 42.00
18.000 -212.37 -692.75 2390.00 5.00 42.00
19.000 -157.89 -653.75 2395.00 5.00 42.00
20.000 -9.88 -654.90 2400.00 5.00 42.00
21.000 -16.37 -588.94 2400.00 5.00 42.00
22.000 134.34 -591.53 2410.00 5.00 42.00
23.000 133.03 -537.35 2410.00 5.00 42.00
24.000 63.49 -471.10 2410.00 5.00 42.00
25.000 74.61 -178.74 2410.00 5.00 42.00
26.000 212.24 -183.73 2410.00 5.00 42.00
27.000 210.40 -45.24 2400.00 5.00 42.00
28.000 238.25 -2.80 2400.00 5.00 42.00
29.000 260.97 27.45 2400.00 5.00 42.00
30.000 314.29 21.93 2400.00 5.00 42.00
31.000 309.91 115.94 2395.00 5.00 42.00
32.000 419.47 112.37 2400.00 5.00 42.00
33.000 421.44 -229.67 2420.00 5.00 42.00
34.000 778.03 -300.05 2430.00 5.00 42.00

Parcel No: 2 -> Points: 6 Status: Active Panel
Point No Easting Northing Seam Extraction Subs.

Elevation Thickness Factor
35.000 417.98 -48.65 2405.00 5.00 29.00
36.000 420.86 113.02 2400.00 5.00 29.00
37.000 313.33 115.85 2395.00 5.00 29.00
38.000 313.57 20.58 2400.00 5.00 29.00
39.000 260.22 24.73 2400.00 5.00 29.00
40.000 211.09 -45.26 2400.00 5.00 29.00

Table 3.14.2: Mine plan coordinates, example #14
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Parcel No: 3 -> Points: 8 Status: Active Panel
Point No Easting Northing Seam Extraction Subs.

Elevation Thickness Factor
41.000 419.33 -231.67 2420.00 5.00 21.00
42.000 417.94 -50.02 2405.00 5.00 21.00
43.000 211.77 -45.28 2400.00 5.00 21.00
44.000 213.59 -184.45 2410.00 5.00 21.00
45.000 75.26 -180.13 2410.00 5.00 21.00
46.000 68.56 -304.69 2410.00 5.00 21.00
47.000 337.84 -306.98 2415.00 5.00 21.00
48.000 338.21 -215.15 2415.00 5.00 21.00

Parcel No: 4 -> Points: 10 Status: Active Pillar
Point No Easting Northing Seam Extraction Subs.

Elevation Thickness Factor
49.000 -89.44 98.35 2390.00 5.00 -13.00
50.000 -141.49 99.72 2390.00 5.00 -13.00
51.000 -148.07 -540.92 2400.00 5.00 -13.00
52.000 -209.83 -544.09 2400.00 5.00 -13.00
53.000 -207.53 -638.73 2390.00 5.00 -13.00
54.000 -105.39 -638.00 2395.00 5.00 -13.00
55.000 -107.91 -421.35 2400.00 5.00 -13.00
56.000 63.19 -404.61 2410.00 5.00 -13.00
57.000 61.87 -376.48 2410.00 5.00 -13.00
58.000 -110.74 -320.53 2400.00 5.00 -13.00

Parcel No: 5 -> Points: 4 Status: Active Pillar
Point No Easting Northing Seam Extraction Subs.

Elevation Thickness Factor
59.000 120.82 92.82 2390.00 5.00 -42.00
60.000 74.95 94.71 2390.00 5.00 -42.00
61.000 76.40 45.33 2390.00 5.00 -42.00
62.000 126.43 45.38 2390.00 5.00 -42.00

Parcel No: 6 -> Points: 4 Status: Active Pillar
Point No Easting Northing Seam Extraction Subs.

Elevation Thickness Factor
63.000 189.84 32.75 2395.00 5.00 -42.00
64.000 150.24 38.59 2395.00 5.00 -42.00
65.000 143.12 -23.59 2395.00 5.00 -42.00
66.000 191.66 -28.30 2395.00 5.00 -42.00

Table 3.14.3: Mine plan coordinates, continued, example #14
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Scattered Points
Transverse Profile

Point No Easting Northing Elevation
186 575.02 -0.15 2834.26
187 549.91 -0.26 2836.55
188 525.11 -0.21 2835.44
189 500.01 -0.16 2832.53
190 475.31 -0.18 2829.46
191 450.27 -0.12 2826.09
192 424.20 -0.11 2822.94
193 400.25 -0.02 2820.42
194 375.08 -0.15 2819.67
195 350.40 -0.19 2820.14
196 325.24 1.13 2820.49
197 300.30 -0.22 2820.76
198 275.31 -0.05 2821.77
199 250.31 -0.20 2823.22
200 225.21 -0.26 2824.45
201 200.21 -0.15 2824.18
202 175.25 -0.28 2822.27
203 150.21 -0.34 2819.70
204 125.37 -0.22 2815.94
205 100.15 -0.24 2811.96
206 75.11 -0.17 2809.03
207 50.10 -0.25 2805.59
208 25.11 -0.27 2803.34
209 -0.03 -0.13 2799.96
210 -24.95 -0.15 2797.76
211 -49.77 -0.29 2791.73
212 -75.64 0.39 2787.67
213 -99.67 0.02 2783.61
214 -125.33 -0.31 2778.05
215 -149.89 -0.08 2774.32
216 -174.94 -0.18 2770.75
217 -199.88 -0.16 2768.04
218 -225.08 -0.17 2765.08
219 -249.76 -0.07 2761.25
220 -274.85 -0.15 2758.27
221 -299.87 0.05 2754.71
222 -324.94 -0.21 2750.46
223 -349.87 -0.07 2746.48
224 -374.80 -0.04 2741.49
225 -399.93 -0.18 2735.62
226 -424.20 -0.13 2733.80
227 -449.97 0.11 2726.78
228 -475.39 -0.13 2721.38
229 -500.35 -0.02 2716.60
230 -523.87 -0.89 2711.98
231 -550.09 -5.46 2706.58
232 -575.19 -6.01 2703.62
233 -599.09 -5.77 2701.52

Scattered Points
Longitudinal Profile

Point No Easting Northing Elevation
234 -0.15 600.43 2703.73
235 -0.33 574.67 2709.03
236 0.10 550.01 2713.94
237 1.14 524.97 2715.99
238 0.19 499.75 2720.67
239 0.15 474.86 2724.51
240 0.15 449.95 2728.80
241 -0.61 424.80 2733.62
242 0.31 399.67 2736.40
243 -0.02 374.42 2738.85
244 0.16 349.50 2741.92
245 -0.03 323.58 2746.09
246 -0.08 299.79 2747.68
247 0.01 275.07 2750.19
248 0.40 249.04 2754.17
249 0.15 224.26 2758.77
250 0.27 199.84 2767.18
251 0.03 175.10 2770.00
252 0.28 149.94 2770.86
253 0.30 124.84 2770.91
254 0.29 99.98 2775.58
255 0.25 75.03 2784.12
256 -0.04 49.86 2789.90
257 0.36 26.41 2798.08
258 -0.04 -0.13 2799.96
259 0.20 -25.24 2802.69
260 0.21 -45.09 2801.82
261 0.07 -75.01 2802.35
262 0.16 -99.65 2800.11
263 -0.50 -124.95 2798.59
264 0.22 -149.87 2795.08
265 0.32 -175.09 2790.60
266 0.25 -199.94 2784.78
267 0.27 -224.97 2779.95
268 0.36 -250.05 2774.73
269 0.22 -275.50 2769.83
270 0.56 -300.06 2765.09
271 -0.85 -324.72 2758.94
272 0.34 -350.12 2754.21
273 0.49 -375.02 2758.21
274 0.55 -399.95 2764.05
275 0.25 -425.13 2771.88
276 0.66 -450.22 2776.86
277 0.49 -475.36 2780.58
278 0.33 -500.18 2787.56
279 -0.06 -525.02 2794.43
280 0.46 -550.19 2797.32
281 0.57 -575.08 2792.31
282 0.43 -599.91 2784.80
283 0.45 -625.22 2777.68
284 0.51 -650.37 2769.98
285 0.48 -675.02 2761.06
286 0.57 -700.41 2749.46

Table 3.14.4: Prediction points coordinates, example #14
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Figure 3.14.2: Comparison of fitted and measured transverse subsidence profiles,
example #14 (points 233-186)

Figure 3.14.3: Comparison of fitted and measured transverse strain profiles,
example #14 (points 233-186)



SDPS Quick Reference Guide, February 2002 72

Figure 3.14.4: Comparison of fitted and measured longitudinal subsidence
profiles, example #14 (points 286-234)

Figure 3.14.5: Comparison of fitted and measured longitudinal strain profiles,
example #14 (points 286-234)
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Figure 3.14.6: Subsidence contours, example #14

Figure 3.14.7: Subsidence orthographic projection, example #14
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Figure 3.14.8: Maximum strain contours, example #14
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Figure 4.1.1: Pillar tributary area

Chapter 4: Pillar Stability Analysis
Calculations
Pillar design should take into consideration the function of a pillar or a set of pillar
during the lifetime of a mining section. Since the original pillar design formulations were
proposed several decades ago, other formulations have been developed to address
pillar stability. The SDPS suite of programs, currently includes a traditional pillar
stability program as well as the pillar stability formulations developed by the USBM
(now NIOSH) regarding stability of pillars in longwall operations and stability of pillars
in room and pillar retreat operations.

4.1 Pillar Design for Room and Pillar
Operations
The pillar stability program uses data that describe mine geometry and overburden
characteristics, as well as coal pillar strength, to calculate safety factors based on four
well-accepted pillar design formulations, namely those proposed by Bieniawski,
Holland, Holland-Gaddy, and Obert & Duvall.

The safety factors associated with the aforementioned pillar equations can be
calculated using the pillar tributary area concept (Figure 4.1.1). Parametric graphs for
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Figure 4.1.2: Protection area under a surface structure

the calculated safety factors can be generated for all formulations.

Also, the program can calculate the dimensions of the protection area (commonly
referred to as “Pennsylvania Law”) a seam level underneath a surface structure.
Extraction within this area should be limited if the surface structure is to be protected
(Figure 4.1.2).

4.2 The ALPS Method
The ALPS program is a stand alone program that was developed by NIOSH and is
freely distributed. It is included in the SDPS suite of programs to allow direct
comparisons of pillar stability calculations. The program can calculate the ALPS
stability factors, utilizing the widely accepted ALPS formulation for assessing pillar
stability.

The ALPS method consists of three basic steps:
• Estimating the loading that will be applied to the pillars during all the phases of

longwall mining;
• Estimating the load-bearing capacity of the longwall pillar system, and;
• Calculating stability factors (SF) by comparing the load to the load-bearing

capacity.

Since its development, the ALPS method has been verified by back-analysis of more
than 100 actual mining case histories (Mark, 1992). A complete discussion of the
formulas used in ALPS can be found in that reference, copies of which are available
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from the author.

Recent research (Mark et al., 1994) has shown that the ALPS SF used in design should
be based on the structural competence of the mine roof, measured by the Coal Mine
Roof Rating (CMRR). A complete description of the CMRR, including field data
collection and procedures for calculating the ratings, have been provided by Molinda
and Mark (1994). Spreadsheet programs for calculating the CMRR are also available
(Riefenberg and Wuest, 1994).

Calculations are performed for two distinct modes:
• the analysis mode (or forward model)
• the sizing mode (or inverse model)

Analysis mode

The calculation phase of ALPS consists of several simple routines which compute the
development loads, the abutment loads, the strengths and load-bearing capacities of
the pillars, and the stability factors. The development loads, which are present before
longwall mining, are determined by the depth of cover using the tributary area theory.
Abutment loads occur as a portion of the weight of the overburden, that had been
supported by the excavated longwall panel, is transferred to the pillars. They are
determined by the depth of cover, the panel width, and the abutment angle.

ALPS calculates the unit strength of the pillars using Bieniawski's empirical pillar
strength formula. The pillar strength is multiplied by load-bearing area and divided by
the crosscut spacing to compute the load-bearing capacity per foot of gate entry. Then
the load-bearing capacity of the longwall pillar system is obtained by summing the
capacities of the individual pillars. Finally, stability factors are obtained by dividing the
system's load- bearing capacity by the total loading.

In this mode, output consists of four (4) screens of data:
• ALPS stability factors
• Pillar load bearing capacity
• Design loadings on pillar system (load per length of gate entry)
• Individual pillar loading

The most important output provided by ALPS in the analysis mode are the stability
factors. These are determined for five loading conditions:

• Development loading: The loading on the pillar system before any longwall
retreat mining. It is equal to the tributary area load.

• Headgate loading: The pillar loading adjacent to headgate corner of the
longwall face, which is equal to the development load plus the first front
abutment.

• Bleeder loading: The loading on a pillar system adjacent to a mined-out panel,
which equals the development load plus the first side abutment.
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• Tailgate loading: The loading on a double-use gate entry system when it is
adjacent to the tailgate corner of the longwall face, equal to the development
load plus the first side abutment plus the second front abutment.

• Isolated loading: The loading on a pillar system located between two mined-out
panels, equal to the development load plus two side abutments.

Since most gate entry systems are used twice, first as a headgate and then as a
tailgate, the stability factor for tailgate loading is usually employed in design. That is
why the results for tailgate loading are marked with asterisks (***) in the output. Single-
use gate entries should be designed for either headgate or bleeder loading. As already
indicated, a Stability Factor between 0.7 and 1.3 is usually appropriate for gate entries,
depending on the CMRR.

The pillar load bearing capacity screen includes the following:
• pillar width,
• width-to-height ratio,
• the unit pillar strength calculated using the Bieniawski formula, and
• the pillar load-bearing capacity per foot along the length of the gate entry.

The total pillar system load-bearing capacity, which is the sum of the load-bearing
capacities of the individual pillars, is the parameter that is needed to compute the SF.
It is compared directly with design loadings that are also provided.

In the analysis mode, the last output screen provides estimates of the loadings applied
to the individual pillars in the gate entry system. The initial development loadings are
calculated using tributary area theory, and the subsequent abutment loadings are
added using the exponential stress decay formula developed in IC 9247, pp. 8-9. As
noted in the output, the individual pillars loadings do not consider load transfer due to
pillar yielding. In general, if the applied stress exceeds a pillar's strength, load transfer
may be assumed to occur. No estimates of individual pillar loads are provided for the
"tailgate" and "isolated" loading phases, because the field data available from those
phases is not sufficient for the development of general formulas.

Sizing mode

In the sizing mode, ALPS will calculate the pillar size required to achieve desired
stability factors that are entered by the user. The user must choose a longwall pillar
configuration from three options:

• a three-entry system employing equal-sized pillars;
• a three-entry system employing a large "abutment" pillar and a small "yield"

pillar, (Yield-Abutment, YA), and;
• a four-entry system employing a single large "abutment" pillar and two small

"yield" pillars (Yield-Abutment-Yield, YAY).

If either the "YA" or "YAY" options are chosen, ALPS requests the width of the "yield"
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pillar. In this case the actual pillar width, rather than the center-to-center entry spacing,
is required.

ALPS also requires "stability factors" (SF) for the sizing mode. The suggested SF
depends on the CMRR for the case being analyzed, and ranges from approximately
0.7 for strong roof (CMRR=75) to 1.3 for weak roof (CMRR=35).

In the sizing mode, ALPS computes the pillar widths that are necessary to achieve the
desired stability factors. A secant variation of Newton's root-solving algorithm is used
to solve the following equation, in which the pillar width is the only unknown:

0 = SF - (B/L)

In the equation SF is the stability factor, B is the pillar system load-bearing capacity,
and L is the design loading. The algorithm terminates when successive iterations have
converged on a pillar width to within 0.1 ft.

In this mode, output consists of four (4) screens of data:
• ALPS pillar sizing results
• Pillar load bearing capacity
• Design loadings on pillar system (load per length of gate entry)
• Individual pillar loading

In the sizing mode, ALPS prints the pillar widths which will provide the specified stability
factors for the specified design type. The pillar lengths are also given, because ALPS
will automatically increase the crosscut spacing to maintain square pillars if the
required pillar width exceeds the user-specified crosscut spacing. Also, as noted on
the printout, the pillar widths and lengths are actual dimensions, not centers.

The remaining 3 screens of output data are similar to those described above for the
analysis mode.

If the Coal Mine Roof Rating (CMRR) is known or can be estimated, the user simply
inputs the proper CMRR, and the program returns a suggested ALPS SF using the
formula:

ALPS SF = 1.76 - 0.014 CMRR

According to Mark et al. (1994) this equation was derived from evaluations of tailgate
performance at more than 60 U.S. longwalls.

The CMRR library is a text file that contains summaries of roof descriptions and CMRR
values obtained from 97 locations. The library helps users estimate the CMRR when
data is not available, and it allows users to check their own CMRR estimates against
observations already made. More complete descriptions of the same 97 observations
may be found in the appendix to Molinda and Mark, 1994.
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4.3 The ARMPS Method
The ARMPS program is a stand alone program that was developed by NIOSH and is
freely distributed. It is included in the SDPS suite of programs to allow direct
comparisons of pillar stability calculations. The program can calculate the ARMPS
stability factors, utilizing the ARMPS formulation for assessing pillar stability.

Preventing pillar squeezes, massive pillar collapses, and bumps is critical to the safe
and efficient retreat mining of coal. To help prevent these problems, the U.S. Bureau of
Mines (now NIOSH) developed the Analysis of Retreat Mining Pillar Stability (ARMPS)
computer program. ARMPS calculates Stability Factors (SF) based on estimates of the
loads applied to, and the load bearing capacity of pillars during retreat mining
operations. The program can model the significant features of most retreat mining
layouts, including angled crosscuts, varied spacings between entries, barrier pillars
between the active section and old (side) gobs, and slab cuts in the barriers on retreat.
It also features a pillar strength formula that considers the greater strength of
rectangular pillars. The program may be used to evaluate bleeder designs as well as
active workings.

A database of 160 pillar retreat case histories has been collected across the United
States to verify the program. It was found that satisfactory conditions were very rare
when the ARMPS SF was less than 0.75. Conversely, very few unsatisfactory designs
were found where the ARMPS SF was greater than 1.5.

The loadings applied to the Active Mining Zone (AMZ) include development loads,
abutment loads, and loads transferred from barrier pillars. The development loads,
which are present before retreat mining, are determined by the depth of cover using the
"tributary area" theory. Abutment loads occur as a result of retreat mining and gob
formation. They are determined by the depth of cover, the width of the extraction front,
the gob extents, and the abutment angles. The abutment loads are assumed to be
distributed following the abutment load distribution function. Only the portion of the
front abutment load that falls within the AMZ is included in the calculation of the SF.
Loads are also applied to barrier pillars, but if the barriers are too small, there are three
ways in which loads may be transferred to the AMZ:

• A portion of the side abutment load may be transferred according to the
abutment load distribution function.

• If the barrier pillar yields, a portion of the side abutment load may be transferred,
and;

• Front abutment loads may be transferred from yielded remnant barrier pillars
inby the pillar line.

Loadings that can occur in ARMPS are:

• Development: Loading Condition: 1, 2, 3, 4
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• Front Abutment: Loading Condition: 2, 3, 4
• Side Abutments: Loading Condition: 3, 4

• Transfer From Remnant Barriers: Loading Condition: 3, 4

Stability factors are obtained by dividing the total load-bearing capacity of the AMZ by
the total load applied to it.

The next, critical step is the interpretation of the stability factor. The ARMPS method
has been verified through back analysis of pillar recovery case histories. To date,
more than 200 case histories have been obtained from 10 states, almost all from mine
visits. They cover an extensive range of geologic conditions, roof rock cavability
characteristics, extraction methods, depths of cover, and pillar geometries. Ground
conditions in each case history have been categorized as being either satisfactory or
unsatisfactory. Pillar failures responsible for unsatisfactory conditions included:

• Pillar squeezes;
• Massive pillar collapses, usually accompanied by airblasts, and/or;
• Coal pillar bumps.

Current research has begun to evaluate other factors that may contribute to satisfactory
conditions when the ARMPS SF falls between 0.75 and 1.5.
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Figure 4.3.1: Pillar geometry parameters

4.3 Example #15: Calculations Using the
Pillar Stability Analysis Module - Estimation
of Pillar Safety Factors

Instructions
1. Execute the Pillar Stability Analysis

Module.
2. Select the Edit - Pillar Stability

option.
3. Enter the following parameters (Fig-

ure 4.3.1):
1. overburden depth = 500 ft

• pillar width = 40 ft
• pillar length = 100 ft
• pillar height = 6 ft
• opening width = 20 ft
• average extraction ratio = 45 %

(note that the tributary area ex-
traction ratio is automatically

calculated and displayed in red)
2. Click on the View Plan button to

see a plan view of the mine section
defined.

3. Click on the Pillar Strength tab of
the current form (Figure 4.3.2).

4. Enter the value for pillar strength
(e.g. 900 psi).

5. Click on the Output Options tab to
select the form of the output, i.e.
either table or graph. In the case of
a graph output, the user can select
between four parametric graphs
(Figure 4.3.3).

6. Click on Display Graph and a
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Figure 4.3.2: Pillar strength parameters

graph of all four pillar strength for-
mulas will be plotted on the screen
(Figure 4.3.4).

7. Close the viewing window.
8. Click on the OK button to accept the

data.
9. Select the File - Save menu item.

Notes for Advanced Users:
1. Optionally the user can use the “Ad-

vanced Geometry” option and enter
the pillar geometry in terms of num-
ber of entries, center-to-center dis-

tance between entries and center-
to-center distance between cross-
cuts. The results are similar but the
extraction ratio is calculated as an
average on all entries.

2. The range for the parametric graphs
is based on a percentile maximum
and minimum values as defined in
the Utilities-Options menu item.
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Figure 4.3.4: Parametric graph for four pillar strength formulas

Figure 4.3.3: Output options
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Figure 4.4.1: Structure and protection area geometry

4.4 Example #16: Calculations Using the
Pillar Stability Analysis Module - Estimation
of Protection Area

Instructions
1. Execute the Pillar Stability Analysis

Module.
2. Select the Edit - Protection Area

option.
3. Enter the following parameters (Fig-

ure 4.4.1):
• overburden depth = 500 ft
• structure width = 40 ft
• structure length = 50 ft
• keep the default values for the

remaining parameters
4. Click on the Results button.
5. The tabulated results will appear on

the screen (Figure 4.4.2).

Note:
The extraction area is based on the as-
sumed recovery, in this example, 50%.
Using an appropriate seam thickness,
this can be converted to extraction vol-
ume and tonnages.
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Figure 4.4.2: Protection area results
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Figure 4.5.1: ALPS stability factors

4.5 Example #17: Calculations Using the
ALPS Module - Estimation of ALPS Stability
Factors

Instructions
1. Execute the ALPS Module.
2. Select the Input - Project Parame-

ters option.
3. Enter the mine geometry parame-

ters as shown in Figure 4.5.1.
4. Keep the default load parameters.
5. Click on OK to exit the edit form.
6. Select the Output - Stability Fac-

tors (Standard Geometry) menu
option.

7. The tabulated results will appear on
the screen (Figure 4.5.2).

8. Select the Output - Graph (ALPS

Classic) menu option.
9. Select the SF vs Entry Height op-

tion. The graph shown in Figure
4.5.3 will be created.

10. Close the forms and save the pro-
ject.

Notes:
• The “Advanced” tab in Figure 4.5.1

allows for entering slanted crosscut
entries (Figure 4.5.4).
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Figure 4.5.2: ALPS results

Figure 4.5.3: Parametric graph for ALPS stability factors
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Figure 4.5.4: ALPS: Advanced geometry
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Figure 4.6.1: ARMPS input parameters

4.6 Example #18: Calculations Using the
ARMPS Module - Estimation of ARMPS
Stability Factors

Instructions
1. Execute the ARMPS Module.
2. Select the Input - Project Parame-

ters option.
3. Enter the mine geometry parame-

ters as shown in Figure 4.6.1. Click
on View to plot the mine plan on the
screen (Figure 4.6.2).

4. Keep the default load parameters.
5. Click on OK to exit the edit form.
6. Select the Output - Stability Fac-

tors menu option.
7. The tabulated results will appear on

the screen (Figure 4.6.3).
8. Select the Output - Graph menu

option.
9. Select the SF vs Entry Height op-

tion. The graph shown in Figure
4.6.4 will be created.

10. Close the forms and save the pro-
ject.
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Figure 4.6.2: ARMPS: Plot of mine plan
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Figure 4.6.4: ARMPS: Parametric graph of stability factors

Figure 4.6.3: Results for ARMPS stability factors
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Chapter 5: The Graphing Module
This SPDS module can create two- and three-dimensional images of the calculated
deformation indices and either display them on the screen or print them to a Windows
device. The main source of input to this program are files created by the solution
modules of the influence function method.

The program can handle two types of files:
• grid files (SDPS grid, Surfer grid and SurvCADD grid files)
• XYZ files

The points represented by a grid file are the points defined at the cross-section of
horizontal and vertical grid lines within the grid boundaries. Thus, grid files contain the
following information:
• the minimum and maximum extent in the x-direction
• the minimum and maximum extent in the y-direction
• the step size in the x- and y-directions
• the number of grid lines in the x- and y-directions
• the value for the z-parameter, i.e. values for a particular deformation index, the

elevation, etc. for all points defined by the grid.

Notes:
Grid files do not contain the x- and y-coordinates for each point, since these values can
be generated based on the above data.

5.1 Two-Dimensional Images: Cross-
sectional plots
Cross-sectional plots generated from grid files can be defined along any (horizontal or
vertical) grid line at any intercept. Depending on the orientation of the cross-section,
the x-axis of the graph will represent either the x- or the y-axis of the grid. The y-axis of
the graph will always be the z-parameter for the corresponding points. The user has the
option to view cross-sections created at different intercept values either on the x- or y-
direction.

When data are available in an XYZ file, which may or may not be defined on a regular
grid, the program can only create one cross-sectional plot, which is termed a directional
cross-section. This plot includes all points in the file taken in the sequence read from
the file, i.e. from first to last. The file specified for the profile should only contain either
two or three columns of data. If the file contains two columns of data, then the program
assumes that the first is the x- and the second is the y-coordinate of the points to be
plotted on the cross-sectional plot. These points are plotted directly without any
scaling. If the file contains three columns of data, then the program assumes that it is
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an XYZ file. In this case the user has three options:

• to use an X-projection (i.e. use the x- and z-columns)
• to use a Y-projection (i.e. use the y- and z-columns)
• to use an Axial projection, in which case the origin of the x-axis is set to zero (0)

and the distance between the points is the actual horizontal (radial) distance.

5.2 Two-Dimensional Images: Vector plots
Vector plot can be created only for those indices where a direction of a horizontal
vector representing this index is available. For example vector plots can be plotted for
the horizontal displacements, for the principal horizontal strains, for the principal
horizontal curvatures as well as for the slopes.

5.3 Three-Dimensional Images
The program can also create three-dimensional graphs. These graphs can only be
generated if deformation have been calculated on a grid. External gridding packages
(such as Surfer or SurvCADD) can be used to grid the prediction points, prior to
calculations.

Notes:
The graphing module can not directly load individual files for plotting. Files are loaded
indirectly utilizing project information generated by the Influence Function Method.
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Appendix 1: Program Reference
This section includes a detailed reference for the menu options for each program
module.
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A1.1 The Profile Function Module
A1.1.1 The File Menu
Use the File menu option to access various file management operations such as:
1. Create New Files

• Use the New option to erase the existing dataset (if any) from memory
and create a new (blank) dataset. All related entries are set to their initial
values. Note that the program will prompt you whether to save the current
file to disk.

2. Open Existing Files
• Use the Open option to load a file (dataset) from the disk into program

memory. To use Open:
i. Select the Open option from the File menu. The program displays

a listing of the available files in the current data directory.
ii. Optionally, select a different drive or directory using the mouse or

the cursor control keys.
iii. Select or enter a filename.

• Notes:
i. If the file extension is omitted, the default extension will be

appended.
ii. If the current dataset is not saved, the program will prompt whether

to save changes or not before discarding the current dataset.
3. Save Files

• Use the Save option to save an existing file (dataset) to the drive or
directory from which it was originally loaded. Any changes that were
made, since the last time the file was saved, will be saved on the disk.
The filename stays the same and the file remains in memory. To use
Save:
i. Select the Save option from the File menu.

• Notes:
i. If the file has never been saved using the Save As option,

choosing Save automatically displays the Save As dialogue box,
which prompts for a filename before saving it.

4. Save Files under Different Names (Save As)
• Use the Save As option to save a file and give it a new name. To use

Save As:
i. Select the Save As option from the File menu. The program

displays a listing of the available files in the current data directory.
ii. Optionally, select a different drive or directory.
iii. Select or enter a filename.

• Notes:
i. If the file exists, the program will prompt whether to overwrite the

existing file.
ii. Use Save for a faster save operation.

5. Print Files
• Use the Print option to print the current dataset (file) from program
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memory to the printer.
• Notes:

i. This operation does not send any control characters to the printer.
All output is ASCII text. All printed text will appear in the default
printer font.

ii. The default values for paper margins are:
left margin = 1 inch
top margin = 1 inch
bottom margin = 1 inch

6. Browse Text Files
• Use the Browse option to view a text (ASCII) file in a specified directory.

Both an internal or an external browser can be used to browse such files.
No editing is allowed during browsing using the internal browser.

• Use the pattern field to specify a file pattern (i.e. *.txt). The file window will
be reset to conform to the specified pattern. The default pattern is *.*.

• More than one patterns can be applied using “;” as delimiter (e.g.
*.txt;*.dxf).

• Use the Set Font command button to specify the type and size of font for
the displayed text in the internal browser. These settings are saved in the
module.INI file.

• Use the cursor control keys to move within the browse window.
• If an external ASCII viewer is used (i.e. NOTEPAD.EXE) as specified in

the Utilities-Settings form, then the maximum file size to browse is set by
the limits of the external browser.

• Notes:
i. The internal browser has a limit of approximately 25000 characters.

7. Exit the Program
• Use the Exit option when ready to exit this program and return to the

original environment. The program will prompt you to save the current file
to disk, if not already saved.

A1.1.2 The Edit Menu
Use the Edit menu option to access various data input, data editing operations and
data graphing operations such as:
1. Project Description

• This is an arbitrary 300 character description of the model being
generated. It is a good idea to make this a fairly detailed description of
the specifics of the input file. This text may be a single line of characters
or may contain "carriage return characters".

• The user can also set the type of units that will be used in the current
project. The program is designed to use two different sets of units: ft and
m.

2. Profile Function Input Parameters
• The profile function method uses data that describe mine geometry and

overburden characteristics to generate a profile of surface subsidence
due to underground mining. The formulation assumes uniform excavation
conditions and calculates subsidence for each half-panel. The following
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parameters are necessary for the calculations:
i. Subsidence Parameter Data: which includes:

(1) The mining system: A longwall or a room-and-pillar mining
system can be selected. If a longwall system is selected, the
extraction ratio input field is disabled and the extraction ratio
is internally assumed 100%.

(2) The panel width: The least panel dimension should be
specified as panel width.

(3) The panel depth (depth of cover or overburden depth): The
depth of cover to the top of the seam should be specified.

(4) The extraction thickness (seam height, mining height): The
term extraction thickness reflects the total thickness mined,
not just the seam thickness.

(5) The extraction ratio: This parameter can only be specified
for room-and-pillar panels. The lower limit currently
accepted is 75%.

(6) The percent hardrock in the overburden (%HR): This
parameter can be determined by calculating the % of
competent strata in the overburden (i.e. limestone,
sandstone beds, etc.)

(7) The surface point spacing: This parameter is used to define
the spacing of the surface points for calculating the
subsidence profile. The points are assumed on a transverse
line starting from the panel center.

(8) The prediction mode: This parameter specifies the type of
prediction equation to be used. The conservative equation
gives an envelop line, while the average equation gives a
prediction which is based on the statistical average of the
database.

(9) The definition of zero subsidence: These parameters are
used to define the point to be considered as point of zero
subsidence. This can be defined either as a percentage of
the maximum subsidence value or as a fixed value (ft or m).
The angle of draw may be calculated based on these
values.

ii. Output Options: These options include:
(1) Results mode: This option allows the user to select whether

to the results in the form of graph (Display Graph) or in the
form of a table (Display Table). The default "results mode"
may be set through the Profile Function Program Options.

(2) Graph mode: This option is enabled only when the Display
Graph option is selected and allows the user to select
whether the graph will display only one curve at a time
(Single Curve) or the graph engine will allow overlaying of
profiles (Append Curve) up to the maximum number
specified in the graph options form. The default "graph
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mode" may be set through the Profile Function Program
Options.

(3) Show Angles from the Rib: This option is enabled only when
the Display Table option is selected and allows the user to
select whether the angles from the rib to each surface point
on the surface will be calculated. This is an indirect way to
calculate the angle of draw, where the user makes the
choice of the cutoff (zero subsidence) point.

(4) Plot Angles of Draw: This option is enabled only when the
Display Graph option is selected and allows the user to
select whether the angle of draw corresponding to each
curve will be plotted on the graph. Note that this option is
automatically disabled when one or more curves are plotted
on the screen. In other words, the user can not select or
deselect this option in the middle of a graphing session. To
enable the option, either clear the current graph or close the
graph window and recreate the last graph.

3. Basic Graph Formatting Options (applies to more than one modules)
• The user can set the basic graph formatting parameters such as:

i. The graph title: The graph title is a text string placed over the
graph.

ii. The graph x-axis title: The x-axis title is a text string placed below
the x-axis of the graph.

iii. The graph y-axis title: The y-axis title is a text string placed to the
left of the y-axis of the graph.

iv. The grid style: Four grid styles are available: Horizontal lines,
vertical lines, horizontal and vertical lines, no grid lines.

v. The graph style: Three graph styles are available: lines, symbols,
lines and symbols.

vi. The maximum number of curves: The user can specify the
maximum number of curves that can be overlaid on the graph.
When this number is exceeded (in the Append Curve mode) the
program will instruct the user to clear the graph before proceeding.

vii. The curve legend: This option enables or disables the legend box
in the graph. When this options is enabled, The combination of a
scroll box and a text box allows the user to modify the default
legend titles for all graphs on the screen.

viii. Symbol size: With this scroll box the user can set the size of the
symbols used by the graph object. The scroll box is enabled only
for a graph type of "symbols" or "lines and symbols".

ix. Default parameter options: There are two default parameter
options: a) to set the default parameters (i.e. graph title, x-axis title,
etc.) every time the graph options form is invoked, and b) to set the
format parameters to used in the previous graphing session. These
values are saved in the corresponding module.INI file.

4. The Graph Form (applies to more than one modules)
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• This form is used to display a graph generated by the calling program.
The menu options available are:
i. [File Import]: This option imports data to the graph from a space or

tab delimited file. This option is not available in all modules.
ii. [File Export]: This option saves the data in the graph in a space or

tab delimited file. This option is not available in all modules.
iii. [File-Save]: This option saves the graph as an image file. The

image file is in WMF format (Windows Metafile). This option is not
available in all modules.

iv. File-Print: This option prints the graph to the default printer.
v. File-Exit: This option clears the graph and closes the graph form.
vi. [File-Exit and Keep]: This option hides the graph form. The form is

shown again when the graphing routines are called. Graphs are
preserved between calls. This option is not available in all
modules.

vii. Edit-Copy: This option copies the current graph object to the
clipboard for use in other applications.

viii. [Edit-Clear]: This option clears the graph and allows plotting of
more curves. This option is not available in all modules. Note that
although the graph is cleared from the screen, the graph
parameters are kept internally. A number of options, such as
enabling or disabling the graph tool bar or invoking the options
form, will restore the graph to the screen.

ix. Options-Graph Toolbar: This option enables the graph tool bar.
Using the graph toolbar the user has more choices regarding the
appearance of the graph than those provided by the basic graph
formatting options. The options in the graph toolbar have their own
on-line help file. This option is disabled by default.

x. Options-Point ID: This allows the user to click on a point a curve on
the graph and the coordinates of this point will be displayed in the
appropriate boxes.

xi. Options-Basic Options: This option loads the graph options form
which includes basic graph formatting options.

• Notes:
i. Command buttons available on some forms are specific to each

module and are usually self explanatory.
ii. Graphics support is provided by Graphics Server 4.53, which is an

independent graph control not included in the Microsoft Visual
Basic 4.0 package.

A1.1.3 The Utilities Menu
Use the Utilities menu option to access various program options such as:
1. Settings (applies to more than one modules)

• This form is used to define a number of default parameters and settings
for the program:
i. Default Units: This setting controls the default units' selection used

when the program is executed. This setting is also used as an
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initial value in the Project Description form. This setting is saved in
the module.INI file.

ii. Default File Extension for Input Files: This setting is the default 3-
letter extension used in the Open and Save dialog boxes in the File
Menu. This setting is saved in the module.INI file.

iii. Data Path: This setting is the default path used in the Open and
Save dialog boxes in the File Menu. This setting is saved in the
module.INI file.

iv. Display Command History Window: This parameter controls
whether the program will display recently executed commands (and
their resulting actions). This setting is saved in the module.INI file.

v. Maximum Characters in Command History Window: Maximum
number of characters displayed in the command history window,
before it is cleared. This setting is enabled only if the Display
Command History Window option is enabled. This setting is saved
in the module.INI file.

vi. Font Type and Size in Command History Window: This button sets
the type and size of font used in the command history window. This
setting is enabled only if the Display Command History Window
option is enabled. This setting is saved in the module.INI file.

vii. Keep Recently Accessed File Names: This parameter controls
whether the program will keep up to four (4) recently accessed
data files (opened or saved) as menu items in the File Menu. This
setting is saved in the module.INI file.

viii. Show Disclaimer: This parameter controls whether the disclaimer
message will be displayed when loading the program. This setting
is saved in the module.INI file.

ix. Maximize Main Menu Window: This parameter controls whether the
main menu window will be maximized when loading the program.
This setting is saved in the module.INI file.

x. Enable Toolbar: This parameter controls whether the main menu
toolbar will be enabled when viewing the main menu. This setting
is saved in the module.INI file.

xi. External Viewer: The user can set the application name of an
external ASCII viewer for viewing reports and other ASCII files
generated by the program. The default viewer in NOTEPAD.EXE
supplied with the windows operating system. Note that prior to
Windows2000, NOTEPAD.EXE could only edit / display files up to
64K. This setting is saved in the module.INI file.

2. Options
• This form is used to define a number of default parameters and options

pertaining specifically to the Profile Function Method Module. These
options include:
i. General

(1) Load Input Screen on File Open: This option will load the
main parameter input screen when the user selects File -
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Open (filename) or File - New.
(2) Print Module Version Information: This option will enable

printing of a module header when a print function is
executed.

(3) Warn User When Input Data Outside Usual Range: When
this option is enabled, then warning messages will be issued
if input data are outside usual range. This option does not
affect data that exceed absolute limits.

ii. Default Settings
(1) Show Angles from the Rib: This option will set the default

option for displaying (or not) angles from the rib when
results are shown in table form.

(2) Plot Angles of Draw: This option will set the default option
for ploting an angle of draw when graphing the calculated
profile.

(3) Default Results Mode: This option will set the default results
mode in the main parameter input screen (display graph or
display table)

(4) Default Graph Mode: This option will set the default graph
mode in the main parameter input screen (append curve or
single curve)

3. Unit Conversions (applies to more than one modules)
• This utility can be used to convert between English and metric units for 4

types of units:
i. Length: Conversion between feet, inches, meters and centimeters

is supported.
ii. Pressure: Conversion between psi (pounds per square inch), Pa

(Pascals) and MPa (MegaPascals) is supported.
iii. Stress (Pressure) Gradient: Conversion between psi/ft (psi per

foot), psi/in (psi per inch), MPa/m (MegaPascal per meter) and
Pa/m (Pascal per meter) is supported.

iv. Load Gradient: Conversion between lbs/ft (pounds per foot), lbs/in
(pounds per inch), kN/m (kiloNewton per meter) and MN/m
(MegaNewton per meter) is supported.

• Notes:
1 Pa = 1 Newton per square meter
1 psi = 1 pound per square inch

4. Clear History Window (applies to more than one modules)
• This option clears the history (activity) window.

5. Close/Restore History Window (applies to more than one modules)
• This option closes or restores the history (activity) window according to

the current window status.
6. Copy History Window (applies to more than one modules)

• This option copies the contents of the history window to the clipboard.
You can then paste them to any text handling program for further
processing.
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A1.2 The Influence Function Module
A1.2.1 The File Menu
Use the File menu option to access various file management operations such as:
1. Create New Files

• This function has three options:
i. Create New Project Files
ii. Create New Mine Plan Files
iii. Create New Prediction Point Files

• Use the New option to load a blank dataset into program memory.
• Creating a new project loads resets the default values for the type of mine

plan, prediction points, units and overburden information.
• Creating a new mine plan, resets the default values for the mine plan.

Similarly, creating a new set of prediction points, resets the defaults
values for the set. To use New:
i. Select the New option from the File menu.

2. Open Existing Files
• This function has three options:

i. Open Project Files
ii. Open Mine Plan Files
iii. Open Prediction Point Files

• Use the open option to load a file (dataset) from the disk into program
memory.

• Opening a project loads saves the mine plan, prediction point and
overburden information from a single file. Opening a mine plan loads just
the mine plan geometry from a file. Similarly, opening the prediction
points, opens just the prediction point geometry from a file. These last two
features are very useful when creating sets of project files based on
similar mine plans, but with different surface topography, or when using
the same surface topography to create project files with different mine
plans. To use Open:
i. Select the Open option from the File menu. The program displays

a listing of the available files in the current data directory.
ii. Optionally, select a different drive or directory using the mouse or

the cursor control keys.
iii. Select or enter a filename.

• Notes:
i. If the file extension is omitted, the default extension will be

appended.
ii. If the current dataset is not saved, the program will prompt whether

to save changes or not before discarding the current dataset.
3. Save Files

• This function has three options:
i. Save Project Files
ii. Save Mine Plan Files
iii. Save Prediction Point Files
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• Use the Save option to save an existing file (dataset) to the drive or
directory from which it was originally loaded. Any changes that were
made, since the last time the file was saved, will be saved on the disk.
The filename stays the same and the file remains in memory.

• Use the Save As option to save an existing file (dataset) under a new
filename specification.

• Saving a project saves the mine plan, prediction point and overburden
information in a single file. Saving a mine plan saves just the mine plan
geometry in a file. Similarly, saving the prediction points, saves just the
prediction point geometry in a file. These last two features are very useful
when creating sets of project files based on similar mine plans but with
different surface topography, or when using the same surface topography
to create project files with different mine plans. To use Save:
i. Select the Save option from the File menu.

• To use Save As:
i. Select the Save As option from the File menu.

• Notes:
i. If the file has never been saved using the Save As option,

choosing Save automatically displays the Save As dialogue box,
which prompts for a filename before saving it.

4. Import Data
• Use the File - Import option to import either an SDPS project created by

SDPS version 4.x software or import SDPS components (i.e. mine plans
and sets of prediction points) from other sources, mainly AutoCAD files.
The import form (for SDPS components) has the following options:

• Import a mine plan from an AutoCAD DXF file. The user should specify
the following:
i. The layer names of active and hidden (not-active) entities. Default

layer names are PANELS for extraction panels and PILLARS for
pillars.

ii. The type of the extracted area (longwall, high extraction room-and-
pillar or low extraction room-and-pillar).

iii. Whether to import elevations from the AutoCAD file or to use an
average elevation as specified in the import form.

iv. The subsidence parameters (subsidence factor or percent
hardrock) associated with every point in each imported parcel.

v. Whether to apply a scale factor to the coordinates imported from
the AutoCAD file.

vi. The thickness for every point in each imported parcel.
vii. Whether to append the data to the existing set or start a new set.

• Notes: Importing will always result in a polygonal mine plan.
• Import prediction points from an AutoCAD DXF file. The user should

specify the following:
i. The layer names of active and hidden (not-active) entities. The

default layer name is POINTS.
ii. Whether to import elevations from the AutoCAD file or to use an
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average elevation as specified in the import form.
iii. Whether to apply a scale factor to the coordinates imported from

the AutoCAD file.
iv. Whether to append the data to the existing set or start a new set.

• Import prediction points from an XYZ (ASCII) file: The XYZ points option
will import an XYZ ASCII data file as a scattered surface point set. The
data can be either space-delimited or comma-delimited. The program will
preview the data file and try to determine the number of header (text
lines), if any, as well as the number of columns in the data set.

• Import a set of prediction points from a Surfer grid file (ASCII). The grid
from surfer option will import a grid of surface points. The Surfer grid file
should be in a DOS format and saved in ASCII. No options are needed
for this function. All information will be retrieved from the grid file header.

• Import a set of prediction points from a SurvCADD grid file. The grid from
SurvCADD option will import a grid of surface points. No options are
needed for this function. All information will be retrieved from the grid file
header.

• Import points and/or panels and/or pillars directly from AutoCAD 2000
DWG files. This selection invokes a new form with the following options:
i. Import points from contours. The user should specify the following:

(1) The file name of the AutoCAD file (DWG file) that holds the
data. The program will read the file and import the layer
names.

(2) The layer names of the CONTOURS as they can be
selected from the combo box.

(3) The entity type for the contour lines. Here only two options
are supported: LWPOLYLINE and 3DPOLYLINE.

(4) Whether to append the data to the existing set or start a
new set.

ii. Import mine plan. The user should specify the following:
(1) The file name of the AutoCAD file (DWG file) that holds the

data. The program will read the file and import the layer
names.

(2) The layer names of the PANELS and the PILLARS as they
can be selected from the combo boxes.

(3) The entity type for the contour lines. Here only two options
are supported: LWPOLYLINE and 3DPOLYLINE.

(4) The subsidence factor associated with every point in each
imported parcel.

(5) The thickness for every point in each imported parcel.
(6) Whether to append the data to the existing set or start a

new set.
iii. Notes:

(1) The routine for reading directly from AutoCAD 2000 was
originally designed by Steven J. Schafrik.

(2) If all input data is digitized to a single AutoCAD file (in
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different layers) then the whole project can be imported in
two steps. One step for the mine plan and one step for the
prediction points.

(3) Surface topography contour lines can be imported as
prediction points only through direct interaction with
AutoCAD 2000.

(4) When importing data in a new project, the program will
automatically switch the mine plan type and/or the prediction
point type to one needed for the import. If, however, data
are imported into an existing project, this process will have
to be done manually by the user.

5. Export Data
• Use the File - Export option to export either a whole SDPS project to

AutoCAD DXF format or to export SDPS components to XYZ format. The
export form has three options:
i. Export the current project to AutoCAD DXF format
ii. Export the current mine plan to XYZ point format
iii. Export the current surface points to XYZ point format

• In the case of AutoCAD output, the program will create a DXF file with the
mine geometry information as well as the surface topography data saved
in separate layers. Note that subsidence information as well as point id
information is lost during this process.

• In the case of XYZ output all data is converted to XYZ coordinates and
stored to files. Additional information such as point ids and subsidence
data are preserved.

6. Print Files
• Use the Print option to print an existing file (dataset) to any windows

printer. This function prints the data as its currently in the computer
memory. This function has three options
i. Print Project Files
ii. Print Mine Plan Files
iii. Print Prediction Point Files

• To use Print: Select the Print option from the File menu.
• Notes:

i. The file prints in the default printer font with a left margin of 1 inch
and a top margin of 1 inch.

7. Browse Text Files
• Use the Browse option to view a text (ASCII) file in a specified directory.

No editing is allowed during browsing.
• Use the pattern field to specify a file pattern (i.e. *.txt). The file window will

be reset to conform to the specified pattern. The default pattern is *.*.
• More than one patterns can be applied using “;” as delimiter (e.g.

*.txt;*.dxf).
• Use the Set Font command button to specify the type and size of font for

the displayed text. These settings are saved in the module.INI file.
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• Use the cursor control keys to move within the browse window.
• Notes:

i. The browser has a limit of approximately 25000 characters.
8. Exit the Program

• Use the Exit option when ready to exit this program and return to the
original environment. The program will prompt you to save the current file
to disk, if not already saved.

A1.2.2 The Edit Menu
The influence function formulation supports several different types of excavation
geometry and prediction point layouts. Data that describe excavation geometry are
referred to as mine plan data, while data that describe the points on the surface (or any
other elevation), where deformation indices will be calculated, are referred to as
prediction point data. Mine plan data can be specified as
• a sequence of closed polygonal lines (polygonal mine plans)
• rectangular entities parallel to the coordinate system (rectangular mine plans)
Prediction point data can be represented by:
• scattered points
• points on a grid oriented parallel to the coordinate system
Use the Edit menu option to access various data input, data editing operations and
data graphing operations such as:
1. Project Description:

• This is an arbitrary 300 character description of the model being
generated. It is recommended to make this a fairly detailed description of
the specifics of the input file. This text may be a single line of characters
or may contain carriage return characters.

• The user can also set the type of units that will be used in the current
project. The program is designed to use two different sets of units: ft and
m.

• When creating a project file, the user will have to specify the type of
mine plan and the type of prediction point data that will be used. The
following combinations may be selected:
i. Polygonal Mine plan, Scattered Points
ii. Polygonal Mine plan, Points on Grid
iii. Rectangular Mine plan, Scattered Points
iv. Rectangular Mine plan, Points on Grid

2. Mine Plan Data - Polygonal Mine Plans
• In this input form the user can specify or modify the geometry and

characteristics of Polygonal Mine Plans. A mine plan may consist of one
or more parcels (panels or pillars). Each parcel is constructed of points
which should be entered in a counter-clockwise direction. Required
parameters for each point include:
i. the point reference code which can be any alphanumeric string,
ii. the easting, northing and elevation of each point,
iii. the extraction thickness at each point as well as the supercritical

subsidence factor at that point (see tables),
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iv. the parcel type, i.e. either panel or pillar,
v. the parcel status, i.e. active or not active (an inactive parcel will not

be displayed in the View option and will not participate in any of the
calculations)

• User Interface:
i. The information for a specific point or parcel can be accessed

and/or modified by using either the sliding pointers or by entering
the serial number of the parcel or point in the Record Management
frame of the form.

ii. A new parcel (or new point within a parcel) may be created or an
existing parcel (or point) may be deleted. The new parcel will be
appended at the end of the parcel sequence (append mode). The
location of any parcel in the parcel database does not affect its
contribution to surface deformations. A parcel should contain a
minimum of 3 points.

iii. If the "Auto Subs. Factor" check box is enabled, the program will
automatically calculated the subsidence factor for the parcel
depending on the value of the "R&P" check box.

iv. The View All command button will display a graph of the currently
defined mine plan as well as the currently defined prediction points
(if any). The View command button will display a graph (map) of
the currently defined mine plan. The Table command button will
load all points in the database in a spreadsheet type of table. This
is considered an advanced editing feature and can be disabled or
enabled through the options form.

• Notes:
i. The cancel command button will be changed to close if irreversible

changes are made to the database. Such changes generally
include editing of more than one point.

ii. The Table command button should be used by experienced users
only, since changes may inadvertetly affect a range of points.

3. Mine Plan Data - Polygonal Mine Plans
• In this input form the user can specify or modify the geometry and

characteristics of Rectangular Mine Plans. A mine plan may consist of
one or more parcels (panels or pillars). Each parcel is represented by a
rectangle which is defined by the coordinates of the four boundary lines.
Required parameters for each point include:
i. the parcel reference code which can be any alphanumeric string,
ii. the coordinates of the west, east, south and north,
iii. the parcel elevation,
iv. the extraction thickness and the supercritical subsidence factor for

that parcel (see tables),
v. the parcel type, i.e. either panel or pillar,
vi. the parcel status, i.e. active or not active (an inactive parcel will not

be displayed in the View option and will not participate in any of the
calculations)
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• User Interface:
i. The information for a specific parcel can be accessed and/or

modified by using either the sliding pointer or by entering the serial
number of the parcel in the Record Management frame of the form.

ii. A new parcel may be created or an existing parcel may be deleted.
The new parcel may be appended at the end of the parcel
sequence (append mode) or inserted at the current position (insert
mode). The location of any parcel in the parcel database does not
affect its contribution to surface deformations.

iii. If the "Auto Subs. Factor" check box is enabled, the program will
automatically calculated the subsidence factor for the parcel
depending on the value of the "R&P" check box. In this case, the
subsidence factor field is disabled and can not be edited directly.

iv. Also, the edge effect at the ribs of the parcel may be considered.
This can be implemented in detail through the Subs. Parms
command button.

v. The View All command button will display a graph (map) of the
currently defined mine plan as well as the currently defined
prediction points (if any). The View command button will display a
graph (map) of the currently defined mine plan. The currently
displayed parcel will be displayed in red on the map. The user may
step through the parcels and visually check the location of each
parcel.

vi. The Table command button will load all parcels in the database in
a spreadsheet type of table. This is considered an advanced
editing feature and can be disabled or enabled through the options
form.

• Notes:
i. The cancel command button will be changed to close if irreversible

changes are made to the database. Such changes generally
include editing of more than one parcel.

ii. The Table command button should be used by experienced users
only, since changes may inadvertetly affect a range of parcels.

iii. The insert/append option button determines the location of a new
parcel within the database. Insert locates the new parcel before
the current parcel, while append adds the parcel at the end of the
list.

4. Subsidence Parameters for Rectangular Parcels
• In this form the data pertaining to the subsidence parameters (i.e. the

estimation of the edge effect around the rib of rectangular parcels of
excavation, and the supercritical subsidence factor) can be specified for
each parcel.
i. If the adjustment option is set to "no adjustment" then the user can

not change any of the input data.
ii. If the adjustment option is set to "manual adjustment" then no

automatic calculations can be performed. The user can enter
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known parameters for each of these fields.
iii. If the adjustment option is set to "automatic adjustment" then

automatic calculations are performed when the user changes any
of the input parameters in this form.

• Input includes the state of the rib (yielding or solid) for each of the four
ribs around the panel, the type of subsidence estimate and the panel
depth and percent hardrock in the overburden.

• Also, the updated coordinates of the panel boundaries can be edited to
be further adjusted.

• Notes:
i. This option is not implemented for polygonal panels.
ii. If the current parcel is a pillar, then this form will be displayed but

no input values can be entered.
5. Prediction point data - Scattered Surface Points

• In this input form the user can specify or modify the geometry of Scattered
Surface Points. A scattered point set may consist of any number of points
that are randomly located on the surface. If such points can be specified
as part of a grid, then the Grid Points option should be used. Required
parameters for each point include:
i. the point reference code which can be any alphanumeric string,
ii. the easting, northing and elevation of each point,
iii. the point status, i.e. active or not active (an inactive point will not

be displayed in the View option and will not participate in any of the
calculations)

• The user can display/modify any point by using either the sliding pointers
or by entering the serial number of the point in the Record Management
frame of the form.

• Also, the user may create a new point or delete an existing point.
• The View All command button will display a graph (map) of the currently

defined prediction points as well as the currently defined mine plan (if
any). The View command button will just display the currently defined set
of prediction points.

• The Table command button will load all points in the database in a
spreadsheet type of table. This is considered an "advanced editing
feature" and can be disabled or enabled through the options form.

• Notes:
i. The cancel command button will be changed to close if irreversible

changes are made to the database. Such changes generally
include editing of more than one point.

ii. The Table command button should be used by experienced users
only, since changes may inadvertetly affect a range of points.

iii. The insert/append option button determines the location of a new
point within the database. Insert locates the new point before the
current point, while append adds the point at the end of the list.

6. Prediction point data - Grid Points
• In this input form the user can specify or modify the geometry of Grid
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Points. A grid point set may consist of any number of points in a window.
This window is defined by minima and maxima in the X- and Y- directions
as well as the cell size in each direction.

• Warning: The grid can only be oriented parallel to the current coordinate
system. If the grid needs to be oriented at an angle to the current
coordinate system, the grid points should be generated by a different tool
and imported as scattered points into the Influence Function module.

• The user has two options regarding grid elevations.
i. to consider a flat surface and specify a uniform elevation for all

points, and
ii. to consider each point on an individual basis and specify individual

point elevations.
• For individual data points, the individual point elevations database should

be initialized using the Initialize command button and then the individual
point elevations can be entered/modified using the Table command
button. The Table command button will load all points in the database in
a spreadsheet type of table. This is considered an "advanced editing
feature" and can be disabled or enabled through the options form.

• The Reset command button can be used to return to the uniform elevation
status. The Generate command button can be used to access the
generate elevations form where elevations can be generated for any
plane in 3-D space.

• The View All command button will display a graph of the currently defined
prediction points as well as the currently defined mine plan (if any). The
View command button will display a graph (map) of the currently defined
set of prediction points.

• Notes:
i. The cancel command button will be changed to close if irreversible

changes are made to the database. Such changes generally
include generation of grid elevations, resetting grid point
elevations, etc.

ii. In this form, the user can not disable any point or group of points.
iii. The Table command button should be used by experienced users

only, since changes may inadvertetly affect a range of points.
7. Generate Grid Elevations

• In this input form the user can specify the necessary geometric data (i.e.
the coordinates of a base point and the plane direction and dip of the
plane through that point) for calculating grid point elevations.

• The generate command button should be used to complete the
calculations and store all calculated elevations in the point data base.

• Notes:
i. Calculations do not affect the coordinates of the grid points.
ii. Data entered in this form are preserved and stored as part of the

prediction point information.
iii. The user may use the "Table" button of the Grid Points form to

further edit generated values.
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8. Spreadsheet Data Editing
• This grid editor allows the user to edit tabulated data in a spreadsheet

manner. The grid editor allows functions such as zooming, cut and paste,
as well as option regarding input (multiple or single cell input, etc.). The
user will be prompted to confirm saving any changes before returning to
the calling form (i.e. definition of a polygonal or rectangular mine plan or
of scattered or grid points).

• This is considered an advanced editing feature.
• Grid editing options can be set through the Grid Options menu item and

include:
i. Select Options: The user can select to mark cells (free), rows or

columns.
ii. Fill Options: The user can select to fill a single cell or range of

cells.
iii. Merge Options: The grid tool can automatically merge columns or

rows of equal values so that the user can easily visualize grouped
entries. Allowed settings are "no merge", "free merge", "restrict
row", "restrict column".

iv. Insert Options: When inserting a row or column, the new column
can be blank or a copy of the current row or column.

v. Paste Options: The user can select to paste the selected range or
the clipped range (if the selected area is different than the clipped
area).

vi. Initial Zoom Setting: The initial zoom setting affects the size of the
characters in the spreadsheet (grid) editor.

vii. Grid Lines: The user can enable or disable the appearance of grid
lines.

viii. Full View: The user can force the grid editor to occupy the whole
computer screen.

ix. Maximize Grid Window: The user can eliminate the controls toolbar
from the grid editor to allow for more editing space.

x. Show Cell Coordinates: The user can enable display of cell
coordinates (Coordinate 1,1 is at the top left corner).

9. Estimate Edge Effect
• This form is used to help the user determine the optimum edge effect

parameter for use in the specific project. The edge effect is a function of
the width-to-depth ratio for each panel and can be estimated in this form.
To calculate the edge effect, enter the panel width and overburden depth
in the form and click on the Calculate command button.

A1.2.3 The Calculate Menu
Use the Calculate menu option to access various data output options and to invoke the
solution and calibration routines:
1. Calculate Deformations

• This form is used to define a number of output options for use by the
solution module of the Influence Function Method Program. These
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options include:
i. File Prefix Code: The user should specify up to a 6 character code

which will be used as a prefix to the resulting deformation files (if
any). For example, if the prefix is "test" then the subsidence file for
scattered points will be testSU.DAT. The default prefix is the first 6
characters of the filename.

ii. Output Path: The user can specify the output path for the result
files (e.g. deformation files and/or report file). The default path is
the current path.

iii. Deformation Indices: The user can specify which deformation
indices should be calculated for each project. Available options
are:
(1) Calculate Subsidence
(2) Calculate Slope
(3) Calculate Horizontal Displacement
(4) Calculate Curvature
(5) Calculate Horizontal Strain
(6) Calculate Ground Strain
(7) Calculate Axial Strain (for scattered data sets only, and

when in sequence -- the program does not check for the
correct point sequence)

iv. Also the user can enable one or all following options:
(1) Generate Report File: This option will generate a report file

(ASCII) which can be either printed or imported into any
word-processing package.

(2) Generate Deformation Files: This option will generate
individual deformation files to be used for graphing through
the Graphing Module.

(3) Generate Grid Elevation File: This option will generate a
grid will all elevation data used in the calculations. This
option is only valid for prediction points on the grid. The
resulting file can be used in the graphing module to plot
elevation cross-sections.

v. Output Format: The user can specify whether output should be in a
grid format (i.e. Surfer or SDPS or SurvCADD) or as XYZ files.
Note that the grid option is only available when prediction points
are initially specified on a grid. Additionally, it should be noted that
the Surfer grid option refers to the Surfer DOS version.

vi. XYZ Format Options: If XYZ Data is selected in the Output Format
Options, then the use can select whether to include a header in the
XYZ files as well as the number of decimals printed for each point
in the XYZ file.

vii. Report Options: If a report is selected, then the options to include
the input data and/or paginate the report can be selected.

viii. Check Panel Orientation: When this option is enabled, the program
will check the orientation of the panels (for polygonal panels only).
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This option may be disabled after a mine plan is checked
thoroughly, in order to speed up calculations.

ix. Calculate: This function is used to invoke the solution module.
When calculations are completed in the solution module, control
returns to the main program.

x. Notes:
(1) All of the above information is saved in the project file.

2. Calibrate Influence Function
• This function allows the user to select the range of the parameters used in

the calibration analysis of the problem. Calibration can only be performed
on polygonal panels with scattered prediction points. Also, the measured
subsidence value should be entered in the appropriate field of the
prediction point set. Once input to this form is modified, the project is
automatically saved before commencing calculations.

• This form is used to define a range for the parameters used in the
calibration process of the Influence Function Method Program. These
parameters include:
i. Minimum, maximum and step factor for the tangent of the influence

angle: The solution procedure with iterate from the minimum to the
maximum value using the step provided and will determine which
option produces the least total error between the measured and
predicted (calculated) values

ii. Minimum, maximum and step factor for the supercritical subsidence
factor for each point in the file: The solution procedure will iterate
from the minimum to the maximum value using the step provided
and will determine which option produces the least total error
between the measured and predicted (calculated) values.

iii. Subsidence Factor Options: The user can select how the program
will handle modification of the subsidence factor during its iterative
process.

iv. Check Panel Orientation: When this option is enabled, the program
will check the orientation of the panels (for polygonal panels only).
This option may be disabled after a mine plan is checked
thoroughly, in order to speed up calculations.

v. Minimum, maximum and step factor for the edge effect for each
side of the polygonal mine plans: The solution procedure with
iterate from the minimum to the maximum value using the step
provided and will determine which option produces the least total
error between the measured and predicted (calculated) values.

vi. Calculate: This function is used to invoke the solution module with
the option to perform parametric analysis in the range specified
previously. When calculations are completed in the solution
module, control returns to the main program.

3. Subsidence Development Curve
• This function allows the user to select the range of the parameters used in

the dynamic analysis of the problem. Currently dynamic analysis can only
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be performed on rectangular panels with any type of points. Once input to
this form is modified, the project is automatically saved before
commencing calculations.

A1.2.4 The Utilities Menu
Utility menu operations are similar to those presented in section A1.1.3. The options
menu item is explained below:
1. Options

• This form is used to define a number of default parameters and options
pertaining specifically to the Influence Function Module. These options
include:
i. Filename Extensions: The default file extensions used in the

influence function program can be set in the corresponding entries
in this frame. These extensions are used when individual mine
plan or prediction point files are specified.

ii. Project Options
(1) Default Mine Plan Type: Use this option to specify the

default mine plan type for a new project.
(2) Default Surface Points Type: Use this option to specify the

default type of surface points for a new project.
(3) Default Subsidence Parameters: Use this option to specify

the default values for the tangent of the influence angle, the
strain coefficient and the percent hardrock.

iii. Advanced Options: Enable or disable these options to enable or
disable the corresponding advanced features of the program.
Currently such features include:
(1) Enable Speadsheet Data Editing: Use this option to enable

table or spreadsheet editing of data files (where
appropriate).

(2) Calibration Feature: Use this option to enable the calibration
option of the Influence Function Method.

(3) Update Project ID: Use this option to enable modifying the
ProjectID in the output options form when saving using the
saveas function.

(4) Enable Advance Vertex Editing:Use this option to enable
editing of vertices for the Polygonal Mine Plans.

(5) Enable Dynamic Analysis Feature: Use this option to enable
the dynamic analysis feature.

(6) Default Graph Index for Dynamic Analysis: Use this option
to select the default graph index to be displayed when
graphing the results from a dynamic analysis.

iv. Miscellaneous Options
(1) User External Viewer to Display Results: Use this option to

enable viewing of result files using an external ASCII viewer.
(2) Print Module Version Information: Use this option to enable

printing the module current version information on all output
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generated by this program.
(3) Default Solution Resolution Parameter: This parameter

applies to the solution procedure for the polygonal mine
plans. A higher value provides more accuracy but takes
more time. The default value is 50.

(4) Confirmation Messages: These options enable a number of
confirmation and/or warning messages in the program.

v. Panel Options
(1) Default Panel Options: These options set the default

environment for editing mine plan panels.
(2) Polygonal Panel Warning Options: These options enable a

number of warning messages during editing of mine plan
panels.
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A1.3 The Pillar Stability Module
A1.3.1 The File Menu
File menu operations are similar to those presented in section A1.1.1.

A1.3.2 The Edit Menu
Use the Edit menu option to access various data input, data editing operations and
data graphing operations such as:
1. Project Description

• This is an arbitrary 300 character description of the model being
generated. It is a good idea to make this a fairly detailed description of
the specifics of the input file. This text may be a single line of characters
or may contain "carriage return characters".

• The user can also set the type of units that will be used in the current
project. The program is designed to use two different sets of units: ft and
m.

2. Pillar Stability Parameters
• The following parameters are necessary for the calculations:

i. Pillar geometry data: which includes:
(1) the average unit weight of the overburden
(2) the average overburden depth
(3) the pillar width
(4) the pillar length
(5) the pillar height
(6) the opening width
(7) the average extraction ratio

ii. Pillar strength data: which includes:
(1) the in-situ uniaxial compressive strength of coal (or

laboratory values or the coal strength factor)
(2) the in-situ uniaxial compressive strength of coal is the most

appropriate value to enter here. If the above value is not
readily known, then it can be calculated using two methods:
(a) by using the laboratory value for the uniaxial
compressive strength of coal and the sample specimen size
and (b) by using the coal strength factor for the particular
seam.

iii. Output options: The user may specify the following output options:
(1) Results mode: This option allows the user to select whether

to view the results in the form of graph (Display Graph) or in
the form of a table (Display Table). The default results
mode option can be set through the Pillar Stability Analysis
Module Options.

(2) Graph selection: Use this option to select the parametric
graph to be displayed if the Display Graph option is enabled.
The default graph selection option can be set through the
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Pillar Stability Analysis Module Options. The following
options are available (SF stands for Safety Factor):
(a) SF vs Pillar Width
(b) SF vs Pillar Height
(c) SF vs Overburden Depth
(d) SF vs Extraction Ratio

(3) Table output:Use this option to select whether to include
header information in the table output as well as, whether to
include the "depth of crushing" calculations.

• Notes:
i. The program will automatically choose the least of the pillar

dimensions for the strength calculations.
ii. The program will automatically calculate and display on the input

form the extraction ratio as calculated from the tributary area of the
pillar (when all appropriate pillar dimensions are entered). The
value used for calculations, however, is the average extraction
ratio entered by the user.

3. Protection Area Parameters
• Use this option to enter surface structure data for a new case study, or to

edit data for a case study loaded from disk. The data will be used to
calculate the dimensions of the protection area at seam level. Also, the
total area of coal in the protection area underneath the structure is
calculated. Required input includes:
i. the average overburden depth,
ii. structure dimensions,
iii. the minimum and maximum angle of protection (measured from the

vertical),
iv. the horizontal structure dimension adjustment, and
v. the maximum extraction ratio for the proposed protection area.

A1.3.3 The Output Menu
Use the Output menu option to access various output options such as:
1. Safety Factors

• Standard Geometry
i. Use this option to obtain the Safety Factors for standard mine

geometry and for all pillar stability formulations
• Result Window:

i. The user may navigate through the result window by clicking on the
Previous Page or Next Page buttons.

ii. Each and all of these output pages may be printed to any Windows
printer.

iii. Each and all of these output pages may be copied to the Windows
clipboard for use in other applications.

• Advanced Geometry
i. Use this option to obtain the Safety Factors for standard mine

geometry and for all pillar stability formulations
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• See Result Window above
2. Protection Area
Using this option, one can obtain the results for the protection area calculations. See
also “Result Window” above.
3. Graph
Using this option, one can produce a series of parametric graphs, such as SF vs
height, SF vs Pillar Width, SF vs Pillar Height, etc.

• Pillar Stability Graph Options: The user can set the basic graph formatting
parameters such as:
i. The graph title: The graph title is a text string placed over the

graph. The default graph title is: "Pillar Stability Analysis".
ii. The graph x-axis titles: The x-axis titles selection includes four text

fields, one for each type of parametric graph that can be specified.
These four fields correspond to the x-axis titles of the following
graph types:
(1) SF vs. Pillar Width
(2) SF vs. Pillar Height
(3) SF vs. Overburden Depth
(4) SF vs. Extraction Ratio
The default text strings for each one of these cases (placed below
the x-axis of each graph) are:

Pillar Width (units)
Pillar Height (units)
Overburden Depth (units)
Extraction Ratio (%)

Note that only then title pertaining to the currently selected graph
can be edited.

iii. The graph y-axis title: The y-axis title is a text string placed to the
left of the y-axis of the graph. The default y-axis title is "Safety
Factor".

iv. The remaining options are explained in section A1.1.2.

A1.3.4 The Utilities Menu
Utility menu operations are similar to those presented in section A1.1.3. The options
menu item is explained below:
1. Options

• This form is used to define a number of default parameters and options
pertaining specifically to the Pillar Stability Analysis Module:
i. General Options

(1) Load Input Screen on File Open: This option controls
whether the main (or advanced) parameter input screen will
automatically be displayed when the user selects File -Open
(filename) or File - New.

(2) Plot Entry Dimensioning: This option will enable plotting of
entry dimensioning when the mine plan input data or results
are plotted on the screen.
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(3) Plot Crosscut Dimensioning: This option will enable plotting
of crosscut dimensioning when the mine plan input data or
results are plotted on the screen.

(4) View Project File in Child Window: When this option is
enabled, the "view" command button in the pillar parameter
screen will launch a child window with the plan view plot of
the mine works. Otherwise, a plot will be generated in the
small window on the pillar parameter form.

(5) Share Geometry Data in all formulations: If this option is
enabled, common geometry data (i.e. overburden depth,
seam thickness, etc., are shared between the active
formulations (i.e. pillar stability, protection area, etc.) in the
module.

(6) Share Strength Data in all formulations: If this option is
enabled, common strength data (i.e. pillar strength, etc.), are
shared between the active formulations (i.e. pillar stability,
protection area, etc.) in the module.

(7) Print Module Version Information: This option will enable
printing of a module header when a print function is
executed.

ii. Default Settings
(1) Calculate Depth of Pillar Crushing: This option will enable

the calculation of the depth for pillar crushing which will be
reported in the tabulated output of the pillar stability module.

(2) Default Protection Angle: This value will be the default
setting for the minimum protection angle in the protection
angle input parameter form. The maximum protection angle
is set 20 deg more than the minimum.

(3) Default Protection Angle Step: This value will be the default
setting for the protection angle step in the protection angle
input parameter form.

(4) Minimum value for Parametric Analysis (%): This percentile
value determines the lower limit of the x-axis in all
parametric graphs.

(5) Maximum value for Parametric Analysis (%): This percentile
value determines the upper limit of the x-axis in all
parametric graphs.

iii. Unit Settings
(1) Output Units (Strength): The user can select the type of

strength units (if English units are selected) that will be
displayed in the output screen.

(2) Output Units (Strength Gradient): The user can select the
type of strength gradient units (if English units are selected)
that will be displayed in the output screen.
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A1.4 The ALPS Module
A1.4.1 The File Menu
File menu operations are similar to those presented in section A1.1.1.

A1.4.2 The Edit Menu
Use the Edit menu option to access various data input, data editing operations and
data graphing operations such as:
1. Project Description

• This is an arbitrary 300 character description of the model being
generated. It is a good idea to make this a fairly detailed description of
the specifics of the input file. This text may be a single line of characters
or may contain "carriage return characters".

• The user can also set the type of units that will be used in the current
project. The program is designed to use two different sets of units: ft and
m.

2. Project Parameters
• The following parameters are necessary for the calculations:
• Parameters of Forward Model:

i. Entry Height: The mining height or coal seam thickness (in feet or
meters).

ii. Depth of Cover: The depth of cover or overburden thickness over
the pillar system (in feet or meters). In regions of sharp topographic
variation it may be too conservative to use the maximum cover if it
is only present over a small portion of the panel, but the average
depth might underestimate the load over the deeper sections.
Some engineering judgement should be exercised, but in general
an appropriate value of the depth of cover for ALPS is a high
average expressed as: H = (Havg + Hmax)/2

iii. Panel Width: The width of the longwall panel (or face length) (in
feet or meters).

iv. Entry Width: The width of the entries. Crosscuts are assumed to be
the same width as the entries (in feet or meters).

v. Crosscut Spacing: The center-to-center crosscut spacing.
Crosscuts are assumed to be driven perpendicular to the entries
(in feet or meters).

vi. Number of Entries: The number of entries to be modelled.
vii. Entry Spacings: The center-to-center spacings (in feet or meters).
viii. In Situ Coal Strength: The in situ coal strength (in psi or MPa). The

default value is 900 psi or 6.2 MPa.
ix. Abutment Angle: The abutment angle in degrees. The default value

is 21 degrees.
x. Unit weight of the Overburden: The unit weight of the overburden

(in pcf or kN/m3). The default value is 162 pcf or 25.47 kN/m3
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• Notes:
i. Users generally will not need to adjust the abutment angle, which

determines the magnitude of the abutment loads, and the in situ
coal strength, which is used in the calculation of the pillar
load-bearing capacity. The research that went into the
development of ALPS indicated that these two variables should be
set at 21 degrees and 900 psi, respectively (Mark, 1992). In
particular, research has found that there is no correlation between
the performance of longwall pillars and the uniaxial compressive
strength of coal specimens (Mark and Barton, 1996; Mark 1999).

• Parameters of Reverse Model:
i. User and Suggested Safety factors: The user may enter a set of

stability factors to be used in the calculation of pillar widths for
each pillar configuration of the sizing mode. Alternatively, the user
may specify CMRR values and the program will display suggested
stability factors for pillar sizing.

ii. CMRR: The CMRR value is used for calculating the suggested
stability factors. If the "Use CMRR suggested factors" check box is
enabled, then the solution routines will ignore the user stability
factors and utilize the CMRR suggested factors. The formulas
used to suggest the SF are defined in the Coal Mine Roof Rating
section.

iii. Pillar Configuration: Sizing can be accomplished using three pillar
configuration options:
(1) Equal Sized Pillars
(2) Yield-Abutment Pillars
(3) Yield-Abutment-Yield Pillars
(4) Yield Pillar Width

• Notes:
i. In the case of a pillar configuration of Yield-Abutment Pillars or

Yield-Abutment-Yield Pillars, the user should enter the yield pillar
width. The yield pillar width is solid coal, not center-to-center!

A1.4.3 The Output Menu
Use the Output menu option to access various output options such as:
1. Stability Factors

• Standard Geometry
i. Use this option to obtain the ALPS stability factors for both the

ALPS (Classic) and ALPS (Revised) formulations under standard
geometry conditions (crosscuts are at 90 degrees to the entries).
The ALPS (Classic) calculates the unit strength of the pillars using
Bieniawski's empirical pillar strength formula, while ALPS
(Revised) calculates the unit strength of the pillars using
Bieniawski's revised empirical pillar strength formula.

• Result Window:
i. The user may navigate through the result window by clicking on the
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Previous Page or Next Page buttons.
ii. Each and all of these output pages may be printed to any Windows

printer.
iii. Each and all of these output pages may be copied to the Windows

clipboard for use in other applications.
• Advanced Geometry

i. Use this option to obtain the ALPS stability factors for both the
ALPS (Classic) and ALPS (Revised) formulations under advanced
geometry conditions (crosscuts are at less than 90 degrees to the
entries). The ALPS (Classic) calculates the unit strength of the
pillars using Bieniawski's empirical pillar strength formula, while
ALPS (Revised) calculates the unit strength of the pillars using
Bieniawski's revised empirical pillar strength formula.

• See Result Window above
2. Size Pillars

• Use this option to size the pillars (see also parameters of the reverse
model)

3. Graph [ALPS Classic]
• Using this option, one can produce a series of parametric graphs, such as

SF vs height, SF vs Depth of Cover, SF vs Panel Width, etc., for the
ALPS (Classic) formulation.

4. Graph [ALPS (R)]
• Using this option, one can produce a series of parametric graphs, such as

SF vs height, SF vs Depth of Cover, SF vs Panel Width, etc., for the
ALPS (Revised) formulation.

A1.4.4 The Utilities Menu
Utility menu operations are similar to those presented in section A1.1.3. The options
menu item is explained below:
1. Options

• This form is used to define a number of default parameters and options
pertaining specifically to the ALPS Module. These options include:
i. Load Input Screen on File Open: This option will load the main

parameter input screen when the user selects File -Open
(filename) or File - New.

ii. View Project File in Child Window: When this option is enabled,
the "view" command button in the pillar parameter screen will
launch a child window with the plan view plot of the mine works.
Otherwise, a plot will be generated in the small window on the pillar
parameter form.

iii. Print Module Version Information: This option will enable printing of
a module header when a print function is executed.

iv. Plot Entry Dimensioning: This option will enable plotting of entry
dimensioning when the mine plan input data or results are plotted
on the screen.

v. Plot Crosscut Dimensioning: This option will enable plotting of
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crosscut dimensioning when the mine plan input data or results are
plotted on the screen.

vi. Output Units (Strength): The user can select the type of strength
units (if English units are selected) that will be displayed in the
ALPS output screen.

vii. Output Units (Strength Gradient): The user can select the type of
strength gradient units (if English units are selected) that will be
displayed in the ALPS output screen.
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A1.5 The ARMPS Module
A1.5.1 The File Menu
File menu operations are similar to those presented in section A1.1.1.

A1.5.2 The Edit Menu
Use the Edit menu option to access various data input, data editing operations and
data graphing operations such as:
1. Project Description

• This is an arbitrary 300 character description of the model being
generated. It is a good idea to make this a fairly detailed description of
the specifics of the input file. This text may be a single line of characters
or may contain "carriage return characters".

• The user can also set the type of units that will be used in the current
project. The program is designed to use two different sets of units: ft and
m.

2. Project Parameters
• The following parameters are necessary for the calculations:

i. Entry Height: The mining height or coal seam thickness (in feet or
meters).

ii. Depth of Cover: The depth of cover or overburden thickness over
the pillar system (in feet or meters). In regions of sharp topographic
variation it may be too conservative to use the maximum cover if it
is only present over a small portion of the panel, but the average
depth might underestimate the load over the deeper sections.
Some engineering judgement should be exercised, but in general
an appropriate value of the depth of cover for ALPS is a high
average expressed as: H = (Havg + Hmax)/2

iii. Crosscut Angle: The angle between the longitudinal axis of an
entry and the crosscut direction (degrees), where 90 is
perpendicular to the entry.

iv. Entry Width: The width of the entries. Crosscuts are assumed to be
the same width as the entries (in feet or meters).

v. Crosscut Spacing: The center-to-center crosscut spacing.
Crosscuts are assumed to be driven perpendicular to the entries
(in feet or meters).

vi. Number of Entries: The number of entries to be modelled.
vii. Entry Spacings: The center-to-center spacings (in feet or meters).
viii. In Situ Coal Strength: The in situ coal strength (in psi or MPa). The

default value is 900 psi or 6.2 MPa.
ix. Unit weight of the Overburden: The unit weight of the overburden

(in pcf or kN/m3). The default value is 162 pcf or 25.47 kN/m3.
x. Breadth of AMZ: The breadth of the Active Mining Zone (in feet or

meters).
xi. Type of Loading Condition: There are 5 types of loading conditions
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that can be modeled: Development Load, One Active Retreat
Section, Active Retreat Section and One Side Gob, Active Retreat
Section and Two Sides Gob, and Bleeder. Each option may require
a number of parameters such as the Abutment Angle (typically 21
degrees), the extend of the active gob, the width of the barrier pillar
on each side and the depth of slab cut in barrier pillar on each
side.

• Notes:
i. Users generally will not need to adjust the breadth of the AMZ

zone, since it can be automatically calculated.

A1.5.3 The Output Menu
Use the Output menu option to access various output options such as:
1. Stability Factors

• Result Window:
i. The user may navigate through the result window by clicking on the

Previous Page or Next Page buttons.
ii. Each and all of these output pages may be printed to any Windows

printer.
iii. Each and all of these output pages may be copied to the Windows

clipboard for use in other applications.
2. Graph

• Using this option, one can produce a series of parametric graphs, such as
SF vs height, SF vs Depth of Cover, SF vs Crosscut Angle, etc.,

A1.5.4 The Utilities Menu
Utility menu operations are similar to those presented in section A1.1.3. The options
menu item is explained below:
1. Options

• This form is used to define a number of default parameters and options
pertaining specifically to the ARMPS Module. These options include:
i. Edit Options

(1) Load Input Screen on File Open: This option will load the
main parameter input screen when the user selects File -
Open (filename) or File - New.

(2) View Project File in Child Window: When this option is
enabled, the "view" command button in the pillar parameter
screen will launch a child window with the plan view plot of
the mine works. Otherwise, a plot will be generated in the
small window on the pillar parameter form.

ii. Print/Plot Options
(1) Print Module Version Information: This option will enable

printing of a module header when a print function is
executed.

(2) Plot Entry Dimensioning: This option will enable plotting of
entry dimensioning when the mine plan input data or results
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are plotted on the screen.
(3) Plot Crosscut Dimensioning: This option will enable plotting

of crosscut dimensioning when the mine plan input data or
results are plotted on the screen.

(4) Plot Extend of Gob: This option will enable plotting of the
extend of gob when the mine plan input data or results are
plotted on the screen.

iii. Output ptionsOptions
(1) Output Units (Strength): The user can select the type of

strength units (if English units are selected) that will be
displayed in the ALPS output screen.

(2) Output Units (Strength Gradient): The user can select the
type of strength gradient units (if English units are selected)
that will be displayed in the ALPS output screen.

(3) Minimum value for Parametric Analysis (%): This percentile
value determines the lower limit of the x-axis in all
parametric graphs.

(4) Maximum value for Parametric Analysis (%): This percentile
value determines the upper limit of the x-axis in all
parametric graphs.
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A1.6 The Graph Module
A1.6.1 The File Menu
Use the File menu option to access various file management operations such as:
1. Open Project

• Use the Open Project option to load a "solved" influence function project
file. The default extension for these project files is "*.GFI" and not "*.PRJ"
which is the default extension for influence function project files. A project
file provides information regarding the deformation indices calculated by
the influence function and the file specifications for each deformation
index file.

2. Load Graph
• Use the Load Graph option to load a saved graph file (see the Save

Graph option below). This option is useful when reviewing a graph saved
through one of the graph forms.

3. Browse
• See discussion in A1.1.1.

4. Exit
• See discussion in A1.1.1.

A1.5.2 The 2-D Menu
1. Use the 2-D menu option to access the two-dimensional plotting options:

• The cross-sectional plots: In this form the user can select the index to be
plotted as well as the formatting parameters for this index. The basic
formatting parameters are as follows:
i. The graph title: The graph title is a text string placed over the

graph.
ii. The graph x-axis title: The x-axis title is a text string placed below

the x-axis of the graph.
iii. The graph y-axis title: The y-axis title is a text string placed to the

left of the y-axis of the graph.
iv. The grid style: Four grid styles are available: Horizontal lines,

vertical lines, horizontal and vertical lines, no grid lines.
v. The graph style: Three graph styles are available: lines, symbols,

lines and symbols.
vi. The maximum number of curves: The user can specify the

maximum number of curves that can be overlaid on the graph.
When this number is exceeded the user will be prompted to clear
the graph before proceeding.

vii. The curve legend: This option enables or disables the legend box
in the graph.

viii. The symbol size: With this scroll box the user can set the size of
the symbols used by the graph object. The scroll box is enabled
only for a graph type of "symbols" or "lines and symbols".

ix. The Default parameter options: There are two default parameter
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options: a) to set the default parameters (i.e. graph title, x-axis title,
etc.) every time the graph options form is invoked, and b) to set the
format parameters to used in the previous graphing session. These
values are saved in the corresponding module.INI file. Note that
when the default parameter set is enabled, changes to the form
components are disabled.

• Notes:
i. Depending on the type of surface points available in the current

project, there are two types of cross-sections that can be created:
(1) Cross-sections plotted from a grid file. In this case, multiple

cross-sections can be overlaid and the user should select
the orientation and intercept of the cross-section.

(2) Cross-sections plotted from a set of scattered points. In this
case, cross-sections can be defined as X-projections, Y-
projections or Axial projections.

• the vector plots: In this form the user can select the index to be plotted as
well as the formatting parameters for this index. The basic formatting
parameters are as follows:
i. The graph title: The graph title is a text string placed over the

graph.
ii. The default parameter options: There are two default parameter

options: a) to set the default parameters (i.e. graph title, x-axis title,
etc.) every time the graph options form is invoked, and b) to set the
format parameters to used in the previous graphing session. These
values are saved in the corresponding module.INI file. Note that
when the default parameter set is enabled, changes to the form
components are disabled.

A1.6.3 The 3-D Menu
1. Use the 2-D menu option to access the two-dimensional plotting options:

• In this form the user can select the index to be plotted as well as the
formatting parameters for this index. The basic formatting parameters are
as follows:
i. The graph title: The graph title is a text string placed over the

graph.
ii. The default parameter options: There are two default parameter

options: a) to set the default parameters (i.e. graph title, x-axis title,
etc.) every time the graph options form is invoked, and b) to set the
format parameters to used in the previous graphing session. These
values are saved in the corresponding module.INI file. Note that
when the default parameter set is enabled, changes to the form
components are disabled.

• Notes:
i. The user can set the rotation and elevation of the 3-D image from

the Graph Form.
A1.6.4 The Utilities Menu
Utility menu operations are similar to those presented in section A1.1.3. The options
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menu item is explained below:
1. Options

• This form is used to define a number of default parameters and options
pertaining specifically to the data export functions of the Graphing
Module. These options include:
i. Format: Use this option to specify whether the exported data will be

in free format or fixed format. See details on fixed format below.
ii. Delimiter: Use this option to specify the default delimiter character

between data columns. The delimiter can either be the SPACE
character or the TAB character.

iii. Fixed format options: Use this option to the fixed format
configuration. The user needs to specify the total width of each
data column (in characters), the number of digits used for the
integer portion of the number as well as the number of decimal
digits. Allowing for one character position for the sign of the
number and one position for the decimal point, the following
relationship should always be true:
NoIntegerDigits + NoDecimalDigits + 2 < ColumnWidth
The default parameters are:
(1) NoIntegerDigits = 6
(2) NoDecimalDigits =3
(3) ColumnWidth = 12
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Appendix 2: The Initialization File
Each SDPS module creates its own initialization (*.INI) file. This initialization file is
automatically created by all SDPS modules the first time they are executed. They
should reside in the home directory of the SDPS programs, i.e. \Program Files\SDPS
for Windows\

• The profile function method module creates and uses the PROF.INI file.
• The influence function method module creates and uses the INFL.INI file.
• The pillar stability analysis module creates and uses the PILL.INI file.
• The graphing module creates and uses the GRAF.INI file.

Sample entries are shown below (the sequence and parameter values may be different
in the actual file):

[Settings]
DefaultUnits=0
DisplayActionWin=1
MaxDisplaySize=300
KeepFileNames=1
ShowDisclaim=0
DataPath=C:\SDPS\
FileExtension=PRF

[FileMenu]
MaxLastFiles=1
LastFile1=C:\SDPS\TEST.PRF

[TextBrowse]
BrowseFontName=Courier New
BrowseFontSize=10
BrowseFontBold=0
BrowseFontItalic=0

Notes:
• If this initialization file is deleted, it will be automatically reconstructed the next

time the program is executed, but the various settings will default to their original
values.
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Appendix 3: Setting up Projects for the
Influence Function Method

A3.1 Common Questions
Question: In what context are the terms panel, pillar and parcel used in the
mineplan definition?
The term panel defines the boundaries of any single extraction area (extraction
boundaries).
The term pillar defines the boundaries of any single pillar. Note that pillars can not
exist outside extraction boundaries (panels).
The term parcel may refer to either a panel entity or a pillar entity.

Question: How can a longwall panel be defined?
A longwall panel can be defined by one parcel which will be specified as a panel.
Everything else around the panel is assumed to be solid material.

Question: How can a room-and-pillar panel be defined?
A room-and-pillar panel should be defined by more than one parcels. One parcel
should be specified as a panel and will define the boundaries of the room-and-pillar
panel itself (extraction boundaries, extraction area) and the remaining parcels should
be defined as pillars within the extraction area (panel).

Question: The mineplan comprises of multiple longwall panels, room and pillar
sections, mains and submains. Should everything be digitized and imported in
SDPS?
An efficient way of modeling a complicated mineplan is to identify areas with similar
extraction characteristics and digitize those areas only. In this sense, a room-and-pillar
section would just be one polygon, a submains section would be another, etc.

Question: The project includes a polygonal mineplan and scattered points. Can
grid points be exported?
No. Grid points can only be exported if a grid is used for the prediction points.

Question: In polygonal mineplans, can the program automatically account for the
edge effect?
No. The program can only automatically account for the edge effect in the case of the
rectangular mineplan.
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Figure A3.2.1: Example of digitized mineplan with
logical errors

A3.2 Examples of Erroneous Panel
Definitions for the Influence Function
Method Formulation
Figure A3.2.1 presents a digitized mineplan, which includes 5 longwall sections, with
the appropriate entries around each panel. However, if this plan is used for surface
deformation calculations using the SDPS package, the results will be erroneous
because there are logical errors in the mine plan description:
• According to the definitions given in Chapter 3, all pillars should be placed

inside extraction areas. In this case, 5 extraction areas are defined, one for each
longwall panel. However, the pillars are not placed inside any extraction area.

• Subsidence calculations for this case will produce negative subsidence in the
middle of the panels and positive subsidence around the panels over the pillars
in the entries.

• One way of producing a mine plan without logical errors would be to create one
boundary line around all mining activity and dismiss the individual extraction
panels, as shown in Figure A3.2.2.

• A second logical error in this plan can be observed when focusing on the last set
of entries (bottom). This detail is shown in Figure A3.2.3. Overlapping pillars can
be observed in this case (due to digitization errors). Their influence will be minor
in the final result, but it is nevertheless a logical error.
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Figure A3.2.3: Detail of bottom entry system: Overlapping
pillars

Figure A3.2.2: Corrected mineplan regarding the
placement of the pillars withing an extraction area
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Figure A3.2.4: Detail of longwall operation with
multiple adjacent extraction areas

Figure A3.2.4 shows in detail the digitized mineplan of a section of another longwall
operation. Here, it appears that each pillared section is enclosed in an extraction area,
which conforms to the specifications. However, this is not the most efficient way to do
these calculations:
• Creating a large extraction area is much more efficient than small adjacent

extraction areas.
• The possibility of creating overlapping extraction areas increases with the

number of small adjacent areas used in a project.
• Increased number of areas results in increased solution times.

A3.3 Examples of Simplifying Problem-
Solving for the Influence Function Method
Formulation
Figure A3.3.1 presents a digitized mineplan, which includes 5 longwall sections, with
the appropriate entries around each panel (mains and submains). Although this is a
“correct” mineplan in terms of definitions, the calculation of surface deformation will
take a long time due to the large number of mineplan points. Figures A3.3.2 and A3.3.3
present an alternative approach to the same problem.
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Figure A3.3.1: Digitized mineplan with 5 longwall sections

Figure A3.3.2: Simplified mineplan where all the mains and submains sections
are considered as one parcel. The two small panels on the right can easily be
added to this layout
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Figure A3.3.3: Very simple mineplan which includes just the extracted
areas of the 5 panels.



SDPS Quick Reference Guide, February 2002 141

Appendix 4: Troubleshooting

A4.1 General Problems
Problem: The registration information does not seem to work. The program does
not allow saving of the license information.
Make sure that you have submitted the correct license code to the supplier and that
you entered the license code correctly. The license code should not contain any letter
O; substitute zero (0) instead.

Problem: The software has been registered, it worked for a while and now it
comes up with the message “Demo expired” and stops working.
In the original versions of the package, installation or re-installation erased all previous
licensing information. However, it kept the date of the first installation as well as a count
of the number of function calls during its demo operation. If re-installation occured after
30 days of original installation or after 200 function calls were performed in demo
mode, then the “Demo expired” message was triggered. Note that this behavior is not
expected for upgrades of versions 5.1P and later. If upgrading from a much older
version, then this message will appear again. Please obtain a new license code from
the supplier.

Problem: Some forms are truncated and may be larger that the current windows
screen.
Most of the forms were designed to fit on a screen with a resolution of 640x480.
However, some forms, need a screen resolution of 800x600 to display properly. To
correct the problem, please set the resolution in the "Settings" section of the "screen
properties" option (right click on the windows screen and select properties), to these
settings.

Problem: Command button captions, form captions and labels are truncated or
wrapped.
The command buttons, forms and labels were designed using the MS San Serif font
(size 8). Changing the default settings for the windows desktop and screen may affect
the appearance of the forms and labels in SDPS 5.x. To correct the problem, please set
the corresponding fonts in the "Appearance" section of the "screen properties" option,
to these settings (right click on the windows screen and select Properties).

Problem: When accessing data through the Table mode (spread sheet mode), the
decimals seem to disappear.
If the localization settings (regional settings) for your Windows environment is set to
allow for xx.xxx,yy instead of xx,xxx.yy then data entry through the Table mode will not
work because this feature is not supported by the 3rd party vendor of this object. Please
revert to US regional settings.
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A4.2 Problems in the Influence Function
Module
Problem: Mine plan files digitized in AutoCAD and saved as a DXF file, can not be
imported or are not properly imported, to the Influence Function Module.
Make sure that:
• the mineplan layers (PANELS, PILLARS, etc.) are defined properly
• the mineplan elements (entities) are digitized as polylines
• the mineplan entities are not defined as blocks
• all mineplan objects are selected when exporting to DXF
• the scaling factors on the input form are reset to 1
• the “append data” option on the input form is disabled

If everything fails, try exporting the mineplan as a DXF file for AutoCAD R12LT (use the
options button in the AutoCAD “dxfout” interface).

Problem: The mine plan has been defined and imported without any problems.
However, when viewing the mine plan, all parcels are clustered in one dot on the
view window.
You may have defined a 0,0 point by accident. The view window tries to fit in all point
and the 0,0 point may be grossly out of scale compared to the XY coordinates of your
mineplan. To correct the problem:
• find the 0,0 point and delete it

Problem: Prediction point files digitized in AutoCAD and saved as a DXF file, can
not be imported or are not properly imported to the Influence Function Module.
Make sure that:
• the prediction point layers (POINTS, etc.) are defined properly
• the elevation values for the points are set to the proper values
• the scaling factors are reset to 1
• the “append data” option on the input form is disabled

If everything fails, try exporting the mineplan as a DXF for AutoCAD R12LT.

Problem: AutoCAD 2000 is installed on the computer. However, no entities can be
imported through the import forms.
Make sure that:
• AutoCAD 2000 if functioning properly in stand-alone mode
• mine plan entities (panels or pillars) are defined as light-weight polylines or 3d

polylines.
• contours are defined as as light-weight polylines or 3d polylines.

If everything fails, try exporting the mineplan as a DXF file.
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Figure A.4.1: Illegal parcel. Its rotation
can not be properly identified

Problem: The “Table” command button is disabled in the mineplan and
prediction points forms.
Make sure that:
• the advanced editing feature is enabled in the Utilities / Options form.

Problem: The project has been defined and saved without any problems.
However, when calculating surface deformations zero values are obtained for one
or more deformation indices.
Make sure that:
• prediction points overlap the mine plan (verify by using “View All” in the

mineplan editor or in the prediction point editor),
• the elevation difference between mineplan and prediction points is properly set,

and it is larger than 0, and
• the seam thickness and subsidence factor values were properly set (for imported

or hand-keyed mineplans).

Problem: The project has been defined and saved without any problems.
However, when calculating surface deformations, positive values for subsidence
are generated.
Make sure that:
• all pillars are surrounded by an extraction boundary (panel),
• there are no pillars that lie outside extraction boundaries, and
• extraction boundaries are defined as panels and not as pillars.

Problem: The mineplan has been digitized exactly as provided. However, the
program predicts surface deformations over mains and areas with less than 50%
extraction.
The method will indeed predict very small surface deformations over areas that should
not experience any such deformations. If such deformations are attributed to mains or
very low extraction areas, then to eliminate them, do the following:
• digitize such areas as unified solid pillars
with appropriate boundary lines.

Problem: When checking the orientation of the
panels, the program identifies parcels that need
to be rotated counter-clockwise and rotates
them either manually or automatically. Re-
running the check routine, the program still
identifies parcels that “need” rotation.
Make sure that:
• these parcels are not “zero area” parcels or

parcels where the perimeter crosses itself
(Figure A.4.1).

Problem: The “Calibration Influence Function”
Option is not enabled.
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Make sure that
• the appropriate option is set in the Utilities-Options form.

A4.3 Further Assistance
In this section common installation and runtime problems were explained. If, however,
you encounter what you feel may be a problem with the software (bug), then please
consult your dealer if you have the latest release of the software. Normally an update
with fixes and upgrades will be issued every 6 months. If your problem is not covered
by the latest software release as provided by your dealer, then please send:

1. the program and module version as shown in menu item “Help / About the
program”,

2. the description of the operating system on your computer (e.g. Win95, WinNT4,
Win2000, etc.)

3. a detailed description of the problem
4. the corresponding files (e.g. DXF, PRJ, etc.), and
5. the steps you had followed when the problem occurred as recorded by the

program (if applicable).
(To do this you may use the “Copy History” feature of the package to copy
the procedure you followed when you encounter the problem to the
clipboard. Paste the copied text in any document or text file and send it
along with your notes.)

by e-mail to zach@mred.tuc.gr. or to mkarmis@vt.edu,



SDPS Quick Reference Guide, February 2002 145

Index
ALPS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15, 76-79, 87-89, 96, 124-128, 130
angle of influence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19, 20, 41, 49, 52, 54
ARMPS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15, 79-81, 90-92, 97, 128, 129
AutoCAD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-59, 107-109, 142
average profile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-26
axial strain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
CMRR . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77-79, 96, 125
coal strength factor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120
conservative profile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24, 25
curvature . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21, 31, 32, 36, 116
DOS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11, 108, 116
DXF . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57, 59, 100, 107, 109, 142, 144
edge effect . . . . . . . . . . . . . . . . . . . . . . . . 10, 37, 38, 52, 62, 65-67, 112, 115, 117, 135
extraction ratio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10, 52, 67, 82, 83, 101, 120-122
extraction thickness . . . . . . . . 10, 24, 31, 37, 41, 45, 49, 50, 52, 54, 67, 101, 110, 111
grid 27, 40-42, 47, 49, 50, 52, 53, 56, 59, 66, 67, 93, 94, 102, 108, 110, 113-116, 131,

132, 135
horizontal displacement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32, 36, 116
horizontal strain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21, 32, 36, 116
influence function . 15, 18, 19, 31-33, 37, 38, 40, 41, 45, 47, 49, 52, 54, 56, 57, 59, 62,

64-66, 93-95, 106, 110, 114, 115, 117, 118, 131, 134-136, 138, 142, 143
longwall . . . 15, 19, 20, 24, 31, 38, 49, 51, 54, 75-78, 96, 97, 101, 107, 124, 125, 135,

136, 138, 139
mineplan . . . . . . . . . . . . . . . . . . . . . . . 26, 41, 44, 49, 52, 54, 60, 61, 135-140, 142, 143
overburden . . . 10, 19-22, 31, 32, 52, 65, 75, 77, 82, 85, 100, 101, 106, 107, 113, 115,

120-124, 128
panel width . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10, 24, 77, 101, 115, 124, 126
percent hardrock . . . . . . . . . . . . . . . . . 10, 19-22, 24, 41, 49, 52, 54, 101, 107, 113, 118
pillar stability . . . . . . . . . . . . . . . . . . . . . 11, 15, 75, 76, 80, 82, 85, 96, 97, 120-123, 134
plot . . . . . . . . . . . . . . 24-26, 48, 90, 91, 93, 94, 102, 105, 116, 122, 123, 126, 129, 130
polygon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37, 135
prediction points . 31, 40, 43, 47, 49, 50, 52-54, 56-62, 67, 94, 106-109, 111-114, 116,

117, 135, 143
print . . . . . . . . . . . . . . . . . . . . . . 16, 30, 62, 93, 99, 103, 105, 109, 118, 123, 126, 129
profile function . . . . . . . . . . . . . . . . . . . . . . 15, 17, 19, 22-25, 27, 29, 99-102, 104, 134
protection area . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76, 85, 86, 121-123
room-and-pillar . . . . . . . . . . . . . . . . . . . . . . . . . 11, 19, 21, 31, 52, 64-66, 101, 107, 135
scattered points . . . . . . . . . . . . . . . . . . . . . . . . . . . 40, 54, 62, 110, 114, 116, 132, 135
seam elevation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37, 41, 45, 49, 50
slope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31, 32, 36, 116
strain coefficient . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10, 21, 41, 49, 52, 54, 65, 67, 118
subsidence . . 10, 19-26, 29, 31, 32, 36-38, 45, 46, 48, 51-53, 56, 57, 62, 65-67, 71-73,

95, 100-102, 107-113, 116-118, 136, 143



SDPS Quick Reference Guide, February 2002 146

subsidence factor . . 10, 19, 20, 22, 37, 38, 45, 46, 52, 62, 66, 107, 108, 110-112, 117,
143

supercritical subsidence factor . . . . . . . . . . . . . 19, 20, 37, 45, 46, 52, 66, 110-112, 117
SurvCADD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59, 60, 93, 94, 108, 116
XYZ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93, 94, 108, 109, 116


